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1 INTRODUCTION 
This education package is meant for people who want to be able to teach Cult3D 
as well as le arning to build interactive objects. 
 

1.1 The purpose and goal of this material 
The purpose of the material is to give you basic understanding of how to prepare 
and export your work in 3D Studio Max, work with Cult3D Designer to create 
interactive events and finally to present your Cult3D file on the Internet. The 
goal is to give you knowledge that you can apply in a meaningful way. 
 

1.2 Composition of this material 
This material is designed so that you may learn Cult3D from the ground and up. 
The material has four main chapters that will take you from start to goal in your 
work.  
 
Chapter 1: Introduction 
Presents the goals and composition as well as the pedagogic idea. This chapter 
also gives a brief presentation of the program and its components. 
 
Chapter 2: The creation and export of a usable file 
Prepares you for the work within the Cult3D Designer, gives you techniques and 
hints on how to maximise the quality of the exportable file from 3D Studio 
MAX. In this chapter you will learn how to install the export plug-in in 3D 
Studio Max. You will also be acquainted with the options of the Cult3D 
Exporter dialog and how to work efficiently with the Exporter plug-in. 
 
Chapter 3: Working with the Cult3D Designer 
Teaches you the basic steps to use objects and work with events, actions, scenes 
and much more. This chapter is the core for learning to understand Cult3D in 
practice. 
 
Chapter 4: Presenting the final result 
This chapter explains how you may compress your Cult3d file before you 
present the final project file on the Internet. You also get some useful examples 
of Java in connection with the Internet. 
 
Appendix 1: An illustrated description of different events and actions in Cult3D 
Designer. 
 
Index: A reference to what page the most important words can be found. 
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1.3 Pedagogical idea 
This material is divided into different parts. The Read  parts the Look  parts the 
Exercise parts and the Finish parts. First you read then you practice. After you 
have completed the exercises you can test your skills in the Review and practice 
chapter. 
 
 

 The "Read" part: 
The read part gives a textual description of all the facts and exercises. It is very 
important to read and understand the material. You will find help text not only at 
the beginning of each exercise you’re working on, but also in between exercises. 
 
 

 The "Look" part: 
The Look part is used only in chapter 3.4 Exercises. It provides you with a 
visual description of each separate tool used in each specific exercise.  
 
 
 

 The "Exercise" part: 
This is the icon for step-by-step exercises. Every step is described so you will 
know exactly what to do and in what order. 
 
 
 

 The "Finish" part: 
This part graphically presents the result you should get when you have 
completed an exercise . You will also find a textual description of how you can 
test the result. The “Finish” part is used only in chapter 3.4 Exercises 
 
 
 
From now on we will use these symbols in every chapter and sub chapter to 
make the journey easier for you. 
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1.4 The practice CD-Rom 

 Included in this material is a CD-Rom with practice files. The 
formats of the practice files are Cult3D designer (*.c3d), Cult3D project 
(*.c3p) and 3D Studio Max (*.max).  
 
The practice files are included to make it easier for you to work. The Exercises 
in this material are based on the files on the CD-Rom.  
 
When you install the Cult3D Designer it will be installed in C:\Program 
File\Cult3D Designer. The sub maps classes, docs, objects, projects, and sound 
will also be created. 
 
You should save all the designer (c3d) files into the object map, the project 
(c3p) files into the project map and the sound (wav) files into the sound map. 
 

1.5 A short presentation of Cult3D 

 Cult3D is a new Multi-platform 3D engine with the purpose to build 
interactive objects for your web pages. Cult3D is a huge technological 
breakthrough. You don’t need a 3D-accelerator card to use Cult3D. 
 
With Cult3D you can visualise different events and functions. You can apply 
various functions on an object and interact with the object. 
 
Cult3D is composed of three different functions; the Cult3D Exporter plug-in, 
the Cult3D Designer and the Cult3D Player plug-in, 
 
The Cult3D Exporter plug-in: 
This is a plug-in for 3D Studio MAX. From the 3D program you can export a 
*.max file to a Cult3D Designer file  *.c3d. 
 
The Cult3D Designer: 
This is the core of Cult3D. It is in Cult3D Designer that you create interactive 
Cult3D objects. 
 
The Cult3D Player plug-in: 
This is a plug-in for Netscape or Explorer. This function of Cult3D is all you 
need to view a Cult3D object on the Internet. 
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The  formats *.c3d , *.c3p and *.co is Cult3Ds different file formats. When you 
export an object from 3D Studio MAX to the Cult3D Designer you can save the 
file as a *.c3d file. This is the format you need in the Cult3D Designer in order 
to work with the file. You save your Cult3D Designer project file with the 
format *.c3p. A designer file may include one or more project files. 
 
When you are finished with your object, you can export it as a finished Cult3D 
object file. The file is saved in the format *.co. When you have done that you 
can then see the object on the Internet if you have the Cult3D player plug-in or 
include it in your office document. 
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2 THE CREATION AND EXPORT OF A USABLE FILE 
 

 The process to create a 3D presentation using Cult3D Designer can be 
divided into 4 steps: 
 
Modelling 
Use your 3D-modeling package (3D Studio Max) and take either an existing model or 
create one from scratch. Remember that even though Cult3D can handle very 
complex objects, the end-user experience is going to be much better with a model that 
is well balanced between not too many details and small size. 
 
Exporting 
Once you are happy with the way the model looks in your 3D modelling application, 
it is time to export it as a Cult3D Designer file *.c3d. This is the file format used to 
maintain a Cult3D object by the Cult3D Designer. (Later we will convert the data 
into something the end-user can view on the web.) 
 
The Cult3D Designer 
Open the *.c3d file into the Cult3D Designer. You can now edit the object in the 
Cult3D Designer by adding events, actions, sounds, etc. 
 
You can preview the end-users view of the object inside Cult3D Designer. That gives 
you a quick and easy iteration process of the design until you are happy with the 
result. When you are finished you may save the changes of the object into a Cult3D 
Project file *.c3p. This allows you to make changes and modifications in the future. 
  
Exporting into a *.co file 
When you are finished with your Cult3D file it is time to create the file that the end 
user will actually view. This Cult3D Player file (*.co) is compressed and heavily 
optimised to reduce file size. This file is arranged to allow the Cult3D Player to start 
displaying the contents even before the whole file is downloaded. 
 
The Exercises in this chapter are based on the assumption that you have a basic 
understanding of how 3D Studio Max works. If not, you should first get acquainted 
with this application. 
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2.1 Hints when you create an exportable file in 3D Studio Max 
 
2.1.1 Planning your work 

 Before you begin to make an object in 3D Studio MAX you must plan to 
get the best results. It’s important to think about how the model will be as a *.co file. 
It is crucial that you plan your work according to the functions you want 
implemented in the object and to build your model from that. 
 
 
2.1.2 Steps to have less polygons on your model: 

 All spline curves are divided into small straight lines that approximate the 
true curve. The number of divisions between each vertex on the spline is called steps.  
The number of steps indicates how many segments you will have when it becomes a 
3D object. The more steps you use the smoother the curve will appear. 
 
It is recommended that you use the optimise option that you will find under 
interpolation. This will also enable the step option. With this option checked the 
program would remove unneeded steps from straight segments in the spline. In the 
step option you can set the number of divisions between each vertex. The valid range 
is between 0 and 100 steps. Splines with tight curves require many steps to look 
smooth while gentle curves require fewer steps. Don’t use more steps than necessary. 
 
By using a low segment number on a standard primitive you can reduce the amount 
of polygons on your object. Each segment is the sum of divisions along each axis of 
the object. The number of segments can be set before or after creation. Don’t use 
more segments then you need.  
 
 
2.1.3 Low polygon modelling 

 There are many ways to make a low polygon object. Here are a few 
suggestions: 
 

• You can either make an object with as few faces as possible from the 
beginning. It is sometimes easier to give the object more faces with smooth 
mesh while building the object.  
 

• You can collapse or weld the vertex to remove some unnecessary faces. This is 
very useful on objects that aren’t round and don’t need segments to look” 
smooth. 
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• You can also combine previous suggestions with smoothing groups that gives 
the object a smooth surface. Each face on the object can have any number of 
smoothing groups. There are 32 different smoothing groups. If two faces don’t 
share the same smoothing groups, the edges between them will render as a 
corner. This is useful if you want to create a cylinder like object by using only 
six or seven segments.  

 
 

 
Exercise  

Create and work with a spline 
In this Exercise you will create a spline in 3D Studio Max. To do 
this you will create a line that only has a few steps.  
 
1. Start 3D Studio Max and create a new file. 

2. Create a line and shape it as a “V”. 

3. Select the modifier. 

4. Click on Sub object and remain in Vertex mode. 

5. Control nodes in a line constitute the Vertex. The complete 

line is called the spline. The area between two control nodes is 

called a segment. A segment is built up by several steps that 

determines how “soft” it will bend. 

6. Select the vertex in the middle and click the right mouse 

button. 

7. Select Smooth. The line will bend like an arc. 

8. Select General under Sub objects.  

9. There you will find Steps. Reduce the number of steps to 0 

and look how it affects the object. 

10. Give the number of steps the value 3. This value represents the 

number of steps the segment is divided in. The more steps you 

have in the segments the softer the arc will be. 
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2.1.4 Linking the objects in 3D Studio MAX  

 The Cult3D Designer support grouping and linking. Select and link is the 
hierarchical relationship between two objects by linking them as child and parent. 
You link from the currently selected object (the child) to any other object (the 
parent). The selected object flashes to show that you have linked to the object.  
 
A child inherits the transformations (move, rotate, scale) applied to the parent, but the 
childs transformation has no effect on the parent. That is why it is very important to 
link according to the outcome of your animation in the Cult3D Designer.  
 
In the designer you can only have one parent that will be used as the rotation point 
centre. If you have an object that has more than one parent it is advisable to link the 
parents to a dummy.   
 

 
Exercise 

Create links 
In this Exercise you will learn how to create links in 3D Studio 
Max. The purpose of the links is to be able to create possibilities 
for animations and interactivity in Cult3D Designer. 
 
1. Start 3D Studio Max and open the file robotarmlinking.max. 

2. Select box01 and box02. 

3. Click the Select and link. Go to the selected boxes with the 

cursor. 

4. Hold down the left mouse button and drag to Spinn05 and 

release the mouse button. Spinn05 will twinkle. 

5. Select the Spinn05.  

6. Hold the left mouse button down and drag to Spinn04 and 

release the mouse button. 

7. Select the Spinn04. 

8. Hold the left mouse button down and drag to box03 and 

release the mouse button. 

9. Select the box03. 

10. Hold the left mouse button down and drag to spinn03 and 

release the mouse button. 

11. Select the spinn03. 
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12. Hold the left mouse button down and drag to spinn02 and 

release the mouse button. 

13. Select the spinn02. 

14. Hold the left mouse button down and drag to cylinder01 and 

release the mouse button. 

15. Select the cylinder01. 

16. Hold the left mouse button down and drag to spinn01 and 

release the mouse button. 

 
 
2.1.5 Pivot points 

 All objects in 3D Studio MAX have a pivot point. The pivot point 
represents the objects local centre and local co-ordinate system. 
 
The pivot point of an object is used as the centre for rotation and it defines the 
transformation origin for linked children, for example if you want a door to open. 
 
Make sure that the pivot points are in the right position before exporting the object. 
 
 
 
 

 
Exercise 

Change of pivot points. 
In this Exercise you will learn how to set the pivot point in a 
3D Studio Max object. The pivot point doesn’t necessarily have to 
be located in the centre of an object. It all depends on what you 
want the object to do. 
 
1. Start 3D Studio Max and open the file robotarm pivot.max 

2. Select box01. 

3. Go to Hierarchy beside the Modifier button. 

4. Select Affect pivot only. 

5. All selectable choices can be seen under Alignment.  

6. Click Centre to object. This sets the pivot point in the centre of 

the object. 
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7. Select the box02 (You still should have Affect pivot only 

selected). 

8. Click Centre to object. 

9. Select spinn03. 

10. Click Centre to object. 

11. Switch to Front view. You can see that the pivot point is in 

centre of the object. 

12. Set Select and move to On. 

13. Select Restrict to X. This limits the movement to the x-axis. 

14. Drag the pivot point to the red “X”. 

15. Select spinn02. 

16. Select Restrict to Y. This limits the movement to the y-axis. 

17. Drag the pivot point to the blue “X”. 

 
 

2.2 The Export plug-in 
 
2.2.1 Installing the Cult3D Exporter into 3D Studio MAX 

 The Cult3D Designer Installer also includes the Cult3D Exporter plug-in 
for 3D Studio MAX. To install the Cult3D Exporter plug-in into 3D Studio MAX you 
need to place the plug-in in the 3D Studio MAX plug-in directory. 
 
The Cult3D Designer Installer attempts to find the 3DStudio MAX plug-in directory 
and place the Cult3D Exporter plug-in there, or you can explicitly specify where the 
Installer should put the plug-in. unless the Cult3D Exporter plug-in is in 3D Studio 
MAX 's plug-in directory it will not work. It is important that you use the correct 
version. 
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2.2.2 Implemented Materials Features  
 

 
 
Ambient Colour: 
The exporter supports ambient colour. 
 
Diffuse Colour:  
Can be used with or without bitmap. Mixes the diffuse colour and bitmap if the 
bitmap amount is less than 100. 
 
Specular Colour: 
Supports specular colour. 
 
Shininess:  
Uses the amount setting for strength. 
 
Reflection Bitmap:  
(Environment mapping.) Uses the amount setting for strength. 
 
Bump Mapping:  
Uses the amount setting for strength. 
 
2-Sided Materials:  
Will support 2-sided materials in a future version 
 
Tiling: 
 Supports tiling but not mirror tiling. 
Compound Materials:  
Standard and Multi/Sub-Object. 
 
Compound Map Types:  
Bitmap (still images.) 
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2.2.3 Special Considerations  

 

 
Object Placement:  
The objects you export use the world axis centre as the centre of the scene in Cult3D. 
The Exporter uses the current frame, so when the time slider is at Frame 14, the 
object's top viewpoint for Frame 14 will be exported.      
 
Entire Worlds into One Object: 
If you make an entire world within 3D Studio MAX, the Cult3D Exporter will always 
act as if it is a single object. 
      
2-Sided Materials: 
3D Studio MAX has an option in the rendering options dialog to force 2-sided 
polygons. Make sure you do not have this option set. If you do, the rendered object 
may be different than the exported one. 
  
Use 2-sided materials with caution as they seriously affect real-time rendering 
performance. Currently the Cult3D Viewer doesn’t use 2-sided materials, even if it is 
specified in the Cult3D object file. This feature will be used in a future version of the 
player. 
 
Metal Shading: 
The Exporter does not support metal shading.  
 
Texture Mapping:  
Currently every texture map you use has an additional footprint size of 256 KB 
during rendering, regardless of the size of your texture. Therefore you should be 
careful with the amount of different texture maps you use. 
 
Bump and Texture  Mapping: 
There is one restriction when using bump and texture mapping together. The tile 
setting and image size must have exactly the same size and value. 
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2.2.4 Features of the exporter 

 

 
 
Polygons: 
Unlimited in each object: 
Even though Cult3D has no limit for the amount of polygons, you should consider 
keeping the total amount low. Unnecessary polygons only slow down both download 
and presentation. 
 
Texture: 
Up to 2048 x 2048 pixels. If the bitmap is larger, it is resized to 2048 x 2048 pixels. 
 
Texture Tiles: 
Sizes from 23 (8) up to 210 (1024) pixels are allowed. Both the x and y sizes must be 
exact powers of 2. I.e., if a tiled bitmap is143 x 78 pixels, it must be shrunk or 
stretched to fit. (See Texture Map Options.) 
 
Shading Methods: 
Constant shading, Flat shading, Gouraud shading with highlights Phong shading are 
the selected shading mode in Exporter. Bump mapping requires Phong shading. 
 
Light Source: 
Infinite Omni Light 
 
Export: 
The Exporter translates object materials and their  properties in 3D Studio MAX to 
Cult3D in order to reproduce the same output result within the possible limits. 
 
Smoothing: 
Smoothing groups are supported. 
 
Optimisation: 
The Optional polygon optimiser minimises the number of polygons in an object by 
merging continuous triangles in the same level. Under some circumstances the 
polygon optimiser may fail. To avoid this you can manually disable this option. 
 
The File Format:  
The file format is compressed and able to stream. It has advanced colour reduction 
for true-colour bitmaps and advanced bitmap compression for smaller file size. 
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Metrics: 
Uses 3D Studio MAX unit settings for converting to Cult3Ds metrics when 
exporting. 
 
Preview: 
Viewer for instant preview of the exported object 
 
 
 

 
Exercise 
 

Export from 3D Studio max. 
In this Exercise you will learn how to export an object from 3D 
Studio Max. You will set the background colour and work with the 
background picture. You will also select the quality of you export. 
The starting point is the file minidisc01.max. 
 
Save file as 
1. Start 3D Studio Max and open the file minidisc01.max. 

2. Select Cult3D Designer in the Save as type menu. 

3. Write Minidisc in the field filename and Save. 

 

The background colour 

4. Select Background. 

5. Click the coloured square in Background colour dialog.  

6. Select the colour you want by holding down the left mouse 

button while dragging the cursor over the coloured square. 

7. Click OK when you have selected a colour. 

8. Click Apply in order to make it visible in the Viewer. 

 
With a background picture in 3D Studio Max 
 

1. Open the Material editor. 

2. Load a material that you want as background. 

3. Select a sphere. 

4. Set Select and move to On. 

5. Select Diffuse . 
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6. Select Bitmap. 

7. Click the Bitmap function (A big square under Bitmap 

parameters). 

8. Select Environment in the Rendering menu. 

9. Click the square under the Environment map. 

10. Click the MTL Editor (Here are all the materials that are 

included in the scene and the spheres). 

11. Find the material you selected earlier. 

12. Double click on the material. 

13. Select Copy. This will make the material remain in the 

material editor. 

14. Close the dialog window. 
 
In the Export dialog 
 
15. Select Background. 

16. Select quality of the picture by dragging the handle and 

pressing Apply. 

17. Click Stretch and Apply. This will allow you to make the 

Preview window bigger. The background picture will adapt to 

the size of the Preview window. 

 
 

 
Exercise 

Bilenar filtering. 
 
1. Select Materials in the Exporter window. All materials will be 

selected. 
 
2. In the Viewer window; zoom the Minidisc so that you can see 

the text on the backside. 
 
3. Select the Option menu. 
 
4. Click the radio button Bilinear filtering located on the tab 

Material.  
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5. Click Apply. 
 
6. You can now see that the text in the back of the Minidsic  looks 

sharper in the Viewer window. 
 
 
Nodes. 
 
7. Select Nodes and make the list show. 

Three tabs will be seen on the right side; General, Camera, and 
Mesh. 

 
8. Select the Mesh tab. 

You will find information about the number of polygons under 
Object properties. 

 
9. Select Optimize on and click Apply  (under Pre optimization). 

The numbers of polygons will decrease from 1920 to 1197. The 
quality of the object will not change. 

 
 
Polygon reduction. 
 
10. To get maximum effect you will have to deselect Optimize on. 
 
11. Select Polygon reduction. You can now decide the amount of 

polygons. Set the value for the polygon to 1000. 
 
12. Click Apply and then Reduce. 
 
Textures. 
 
This function makes it possible to decide the quality of one texture 
or all textures. 
 
13. Select all textures. 
 
14. Zoom the Minidisc  in the viewer. 
 
15. Select 24 bits in Image compression and click Apply. 

You will now get a high quality picture and reduced file size. 
 
 
If you are satisfied with the result; click Save. 
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2.2.5 Known Problems  

 We have noticed that under some circumstances 3D Studio MAX will not 
tell the export plug-in that a texture has been updated or loaded. This sometimes 
occurs if you do not render the scene before exporting it, or when you have changed 
an existing texture via reload. The easiest workaround is simply to exit 3D Studio 
MAX and restart it. 
 
 
2.2.6 The Cult3D Exporter Dialog with options 

 When running 3D Studio MAX, the Cult3D Exporter will be found under 
File/Export. 
 
1. Select C3D in the Save as type List box 
2. Type a filename for the object you want to export 
3. Click Save and you will see the dialog with export options 
 
The actual Exporter consists of a tree view with all the exported information, as you 
can see below. On the right side of the Exporter window you can see a tab 
representing what type of information you have selected in the tree view.  
 
Initially you will see the Header and its tab. There are four different tabs. The 
Material, the General, the Mesh and the Texture Tabs are available.  
 
Select Materials, or any material under the expanded Materials in the tree view to see 
the materials tab. Likewise for textures. The Nodes info is a little bit different. Under 
the nodes, you will see a hierarchy of all the objects. They always have a General 
Tab, but if the object for instance is a mesh then the mesh tab also will be shown. We 
explore this later on in this guide. The one th ing that doesn't change is the buttons and 
the status bar.1 
 

 
Figure 1: The Cult3D Exporter 
 

                                                                 
1  This applies to version 3 and earlier. 
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The tool bar 
 

 
Figure 2: The tool bar 
 
The About button: 
The "About" button will show you our copyright text and contact information.  
 
The Cancel button: 
The "Cancel" button will cancel the operation and quit the Exporter.  
 
The Exit button: 
Exits the Export window. 
 
The Save button: 
The "Save" button exports all the settings and data into a *.c3d file and also into 3D 
Studio MAX memory. After it has saved all the data, the Exporter will quit. 
 
The Reduce button:  
When you have applied your polygon reduce settings on your object or objects, the  
“Reduce” button will get activated. Now you are able to press it to actually begin the 
reduction process. 
 
The Apply button: 
The "Apply" button is used to confirm the changes you have made in the different 
tabs. NOTE: If you have made some changes and have not pressed "Apply", then 
when you press the “OK” or the "Save" button those changes will NOT be included. 
This is also true regarding what you actually see in the Viewer. The changes take 
effect only after the "Apply" button has been pressed. If the "Apply" button is grey 
that tells you that no changes have been made. 
 
The Viewer button: 
The Viewer button will activate a window where you can see the exported data and 
the settings you have made or will make. 
 
The status bar 
The status bar consists of three different parts. Beginning from the left, we have the 
actual status text of the on-going procedure. The next part is a progress bar for the 
specified procedure and the last part is the progress bar for all the procedures. When 
the last part is finished, you can either save or do more changes. 
 
The Tree view & Selection 
The tree view in the Exporter is where you do all selections for the settings. You have 
five main categories, Header, Background, Materials, Nodes and Textures. 
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Figure 3: The Cult3D Exporter 
 

All except Header and Background have 
multiple selections. If you for instance have 
selected Materials , you have then selected all 
the materials you have on a specified 
object/scene. If you want to individually 
select the materials, you can do so by opening 
up the Materials, either by double clicking on 
that category, or pressing the "+" button. 
 

The Nodes categories do not only contain the actual objects or meshes as we have 
called them, but also cameras and dummy objects (Helpers). The hierarchies of the 
different nodes are also exported and can be seen in the tree view.  
 
Multiple selection only works within each category. Selections of specific functions 
are done in a normal Windows fashion. To select multiple items you click the first 
one. Then press and hold down the Ctrl-key and click the other items you want. You 
can use the Shift key in the same way to select a range of items starting with the first 
one you click and ending with the second one you click. 
 
The Header Tab 
When you have selected the "Header" in the tree view, you will see the Header tab as 
shown in figure 4. You can see the information we got from the exported scene from 
3D Studio MAX. Some of the information here can change. For instance, if you 
optimise the polygons on your meshes the total amount of polygons and vertices may 
be changed. Here you may also change the name of an object/scene and copyright 
notice. 
 

 
Figure 4: The Header tab 
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The Materials Tab 
 

 
Figure 5: The Material tab 
 
The Shading type area: 
In the Shading type area you can set the desired shading on your object. You have 
four choices that are described below.  
 
Constant shading: 
The Constant shading type doesn’t use any lighting.  
 
Flat shading: 
The Flat shading uses the lighting, but the objects using a material with flat shading 
will get faceted.  
 
Gouraud shading: 
The Gouraud shading uses the lighting and gives a smooth appearance of the object. 
Cult3D Gouraud shading also shows a highlight. This highlight is calculated at vertex 
level. 
 
Phong:  
Gives an even smoother appearance of the material since its highlight is calculated at 
pixel level. 
 
The Options area: 
By checking the Bilinear Filtering option, the texture in this material will get filtered. 
This applies only to a material where only one texture is used. If you are mixing 
textures, for instance applying a reflection texture onto a textured material, you 
cannot use the Bilinear Filtering. A single texture used for Bump mapping cannot use 
the Bilinear Filtering either. 
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Nodes 
 

 
Figure 6: The General tab 
 
 
The General tab 
Every node that we export has a general tab. A node can also be a Mesh  or a Camera 
or a dummy object. In the general tab you will see information of the selected node. 
 
Animation: 
If this is checked, then all matrix animation will be included in the selection. Matrix 
animation in other terms is the collection of rotation, scale, and translation of the 
object. 
 
Hide Object(s): 
If you have checked Hide Object(s) then the selected objects will be hidden. They 
will be included in the saved file, but they are initially hidden. 
 
The Mesh Tab 
 

 
Figure 7: The Mesh tab 
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Pre Optimisation: 
Setting “Optimise On” will enable the optimisation of your object. “Remove 
Vertices” is an extra setting that improves the optimisation result. If you intend to use 
polygon reduction you normally should turn off the "Optimise On" setting. 
 
Object information: 
From the tree view you can select one or multiple meshes, and all the selected meshes 
will calculate the total amount of polygons and vertices to be displayed here. 
 
Vertex animation: 
By checking this option you will include all the vertex animation of the object. 
Vertex animation is an individual movement of each vertex, so if you use a skin on a 
Character Studio character that deforms the skins when animating the bones, then you 
will need to check that we can export the Vertex animation of the object. 
 
Polygon reduction: 
This is an advanced feature for reducing the amount of polygons used in an object. 
This is a less drastic reduction than the optimiser performs. By reducing the number 
of polygons in your object, the rendering performance increases and the file size of 
the object gets smaller. The reducer employs a set of advanced algorithms, including 
differential evolution and experience-based algorithms. 
 
The end result depends a lot of the object, so this is a feature you need to experiment 
with for each new object to get a result to your satisfaction. You can define a 
percentage to reduce or enter the amount of polygons you would like to get. The join 
“Coincident Vertex” check box is a feature used as a measure against problems with 
models where cracks show up in the model after the reduction process. If this 
happens on any of your models, click this check box and try again with the original 
model. If the cracks still show up, try a larger factor for the joining. What this 
technique does is to weld together vertices that are very close and are meant to have 
the same position. During reduction, such vertices might slide to their side making 
cracks appear in the reduced model.  
 
The Texture  tab: 
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Figure 8: The texture tab 
Texture map options: 
Due to the power-of-2 limitation on texture sizes, the Exporter will automatically 
resize a "non-valid" size to a correct size depending on your settings. “Lower” means 
that it will resize to the next lower even power-of-2 size. “Nearest” chooses the 
nearest corresponding size. “Higher” chooses the next larger size. 
 
For instance, if the bitmap is 260 x 200 pixels  and you choose "Lower”, then the 
bitmap will be resized to 256 x 128 pixels. If you choose "Nearest" the result will be 
256 x 256 pixels and if you choose “Higher” the result will be 512 x 256 pixels. None 
of these settings will go higher than the Maximum Texture size setting. If you choose 
“Use Max” as size, then all textures will be resized to the Maximum Texture size 
settings. For your convenience, you can set Lock XY-size so that when you drag the 
“X” slider, the “Y” slider follows. 
 
Image Compression: 
You have three different methods to save your textures in the Cult3D file. The first 
one is 24-bit lossless, which mean that the texture will be saved in 24-bit depth the 
program uses a simple RLE compression algorithm for this to compress the image 
with no loss of quality whatsoever. Using the 8-bit palliated option will save space 
compared to the 24-bit option. But the texture may become a bit loose. If the input 
image was a 24-bit image you need to quantify the image.  
 
Normally, these two methods to save the textures will never be used because 
compressing with a wavelet algorithm will keep a lot of in formation and keep the size 
of data exceptionally small.  
 
So if Wavelet is set, you will be able to set the compression slider. Cult3D uses an 
advanced compression algorithm to make your bitmaps as small as possible. In the 
slider you can set the desired image quality. The value is always depending on your 
objects texture maps. For a more detailed discussion, see the section on Compression 
below. 
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2.2.7 Different types of compression 

 Cult3D supports various levels of compression for several different areas 
of representation of an object. 
 

Types of Compression 
 Loss-less: Lossy: 
Texture 
Maps: 

The full texture map is 
stored. 
 

Cult3D will use a wavelet based 
image compression algorithm to 
save space. The object author can 
set the fidelity of the compression. 
 

Vertices: 
 

The exact positions of 
each vertex is stored 
 

The geometry compression 
algorithm can slightly distort the 
actual object geometry depending 
on the shape of the object. 
 

Sound 
 

The data is stored as is. 
Sounds from *.wav 
files are compressed 
roughly 50%. MIDI 
data is not compressed 

The sound data is compressed using 
for instance a wavelet algorithm. 
The object creator can set the 
fidelity of the compression. 

 
Let's look at a practical example of texture map compression. The image on 
the left is what we start with. It is a large (256x240pixels, 24bits, 184Kb) 
texture map. 

 
Figure 9: Texture map compression 

 
Figure 10: A detail view 
 
The pictures shown here are only 
approximations of the real textures stored 
inside the Cult3D P layer file (*.co) since 
in reality the texture is stored using a 
special wavelet compressed image format. 

 
By trading off a small amount of quality, we can greatly reduce the size 
(quality set for 50%, 256x240pixels, 24bits, 8.6Kb). For only a moderate 
change in quality we saved 175Kb (a savings of over 95%!). 
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Figure 11: Quality reduction 

 
Figure 12: A detail view 

 
We can take this even further and set the quality to 0%. The resulting file is 
now down to a mere 0.925Kb (still 256x240pixels and 24bits). But as we 
can see the quality has suffered a great deal. 

 
Figure 13: Zero quality  

 
Figure 14: A detail view 

 
This level of severe compression is very useful for reflection maps. If 0% is too much 
compression, try a value below 15%. 
 
The Background Tab: 
The background tab works almost like the texture tab. Here you can define the 
quality/compression of the background image. It only uses the Wavelet compression 
method. A background image doesn't have the power-of-2 limitation like a texture 
map has, and therefore the original bitmap resolution will be saved. 
 
You may select “Tile” if the viewing area is larger than the actual background image, 
or you may "Stretch" (scale) the image to always fit into the viewing area. You can 
also override the background colour taken from 3D Studio MAX and select a new 
Background colour of your choice.  
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Figure 15: The background tab 
 
 
The Viewer 
The Viewer let you view the actual exported scene/objects. You can rotate and zoom 
in real-time and even play the animation if you have exported it. In the tool bar at the 
top, you have 3 buttons for the animation, Play, Pause and Stop. You also have six 
fast view buttons. With these buttons you can quickly choose an orientation for the 
view. 
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3 Working with the Cult3D Designer 
This chapter is all about getting to know the Cult3D Designer in practice. First you 
will get acquainted with the basic functions of the program, then you will explore the 
user interface and finally you will create presentable files in practice. 
 

3.1 Starting the program 
 

 
Exercise 

Start Cult3D Designer and open the file Drawer.c3d. 
 
1. click the Start button 
2. Select Program and Cult3D Designer 
3. Scroll the text and click on the button I agree 
4. Select Load Cult3D Designer file in the File menu  
5. Select drawer.c3d and click the button Open. 

 

3.2 The Basic Functions of the program 

 
Read 

This part deals with the basic functions of the Cult3D Designer such as 
opening different types of files, working in an interactive way and 
saving your work. 
 

 
 
3.2.1 Open a designer file  

 
Exercise 

Open the designer file minidisc.c3d. 
 
1. Select Load Cult3D Designer file in the File menu. 
2. Select the designer minidisc.c3d . 
3. Click the OK button. 

 
 
3.2.2 Create user interactivity 

When you want to achieve object interactivity you will always work with tools from 
the Event map window, the Scene graph window and the Actions window. 
 

 
Exercise 

Give the designer file user interactivity. 
 
1. Drag and drop a World start object into the Event map 
2. Select the minidisk object in the Scene graph window and 

drag it to the Event map window. 
3. Drag and drop Arcball onto Event_1. You will find it under 

actions/object motion. 
4. Drag the minidisk icon to the Arcball 
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3.2.3 Save your work 

When you save the settings and work of your project the file will be saved as an 
*.c3p file. To be able to open the *.c3p file you must also have the *.c3d file. 
Everything is saved except the actual object. This makes it possible to change the 
object a without having to create the entire layout again. 
 

 
Exercise 

Save a project file. 
 
1. Select the File menu. 
2. Select Save project as. 
3. Name the file minidisc.c3p 

 
 
3.2.4 Open the project file  
 

 
Exercise 

Open the project file minidisc.c3p. 
 
1. Select the File menu. 
2. Select Load project. 
3. Select minidisc.c3p 

 
 
3.2.5 Summary 

When you load a Cult3D project file this file include the designer file location, the 
entire event, actions and the layout of the presentation. 
 
When you save your work  the Cult3D project file will be updated and saved. If no 
project file previously was saved the program will show the dialog “Save project as”. 
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3.3 The user interface 

 
It is important to get acquainted with the user interface and the special 
terminology used in the graphic world and in this application.  
 

 
3.3.1 Acquainting yourself with the different windows  

Under Cult3D Designer there are seven different windows. You can move them, 
make them smaller or make them bigger, whatever you desire. 
 
1. Event map 
 

2. Objects properties 3. Actions 

4. Events  5. Scene graph 6. Preview 
 

7. Object position and orientation  
 

 
Figure 16: The user interface 
 
 
3.3.2 Different events 

An event is used to trigger an action. An event can be a “Left mouse click”, a “right 
mouse click” or a “middle mouse click”. It can also be a “pressed” or “released” key 
on the keyboard. Events specify the input that triggers or drives the actions in the 
scene.  

1
5

7

3

6

4
2
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3.3.3 The options menu listings for the settings of an event 
If you click the right mouse button on an 
event you can select the Options menu  
 

 

All new events that are added to the “Event 
map” window are initially set to “Initial 
activation” and Automatic Reset. 
 

Figure 17: The Options menu  
 
Initial activation:  
An event can only be self-triggered if “Initial activation” in the option menu is 
selected. If you deselected “Initial activation” you have to attach another event that 
triggers the original event. Connecting the action “Activate event” to both events 
does this.  
 
Automatic Reset: 
Events can only be triggered when they are in the reset state. All events start out in 
the reset state, but once triggered they must be reset before they can be triggered 
again. You can either do an explicit reset with a Reset Event action, or you can set it 
to automatically reset after it has been triggered by checking the Automatic Reset 
option in this menu. 
 
Example 1:  
Attach a “Left mouse click” event to an object. Unless Automatic Reset is activated 
(or the event is explicitly reset with a Reset Event action) the end-user will only be 
able to trigger it once by clicking. 
 
Example 2:  
If you set a “Timer” event to trigger a “System Beep” action after 2000ms, and 
enable “Automatic Reset”, then the beep will sound every two seconds. 
 
Change Name: 
Changes the name of the event. 
 
Parameters: 
As a drag and drop alternative you may choose this selection to connect Scene graph 
objects to the events. 
 
Edit: 
This selection allows you to change the event name, and the event type. You may 
also select activation or deactivation for Initial activation. You can access the 
parameters for events and actions from this dialog box. 



  Chapter 3: Working with the Cult3D Designer 
 

 Page 31 

 
Edit with a time line view: 
This dialog allows you to set the start and stop time and order for the actions 
connected to an event. 
 
Collapse Inputs: 
Collapses the tree of objects and actions to one icon. Deletes the event. 
 
Delete: 
If you select Delete you will remove the event and connected actions from the Event 
map window. 
 
3.3.4 The Scene graph window 

 

The Scene graph window shows a hierarchical view of the 
data associated with objects and cameras. You can use the 
“Scene graph” to drag object icons to the Event map. 
 
It is possible to change the order and dependence of the 
visible scene graph objects by dragging and dropping them 
on each other in the desired hierarchy. By doing this you 
may connect and disconnect objects from each other. 

Figure 18: The Scene graph window 
 
 
3.3.5 The Preview window 

Everything that is done to the object and scene is shown in this window. Here you 
can try out the scene, just as the end-user will do in a browser window. The Preview 
window is fully interactive and you can even left-click an object in the scene, and 
have that object highlighted in the Scene graph. 
 
 
You can also drag an object directly from the Preview window to the “Event map” 
(by holding down the control key while left-dragging the object). The result is a 
rendered icon of the object in the “Event map”, thus making it much easier to set up 
complex event maps. 
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The toolbar in the Preview window has eight different buttons: 
 

 Show axis:  
Toggles the display of each object's pivot point (or "centre", i.e., the point the object 
rotates around).  
 

 Show bounding box: 
Clicking this is button shows you the boundaries of the selected object. 
 

 Reset object:  
Resets translation and rotation values of the object to initial values. Very useful if you 
have been fiddling with the object for a while and want to get back to initial 
conditions.  

 
 Use arcball:  

When this toolbar button is pressed, you can rotate, zoom, or translate the object by 
clicking and dragging with the mouse. When the toolbar button is not pressed, 
clicking with the mouse only affects object selection.  
 

 Pick objects: 
This button allows you to select an object in the Preview window. The object you 
selected will be shown in the Scene graph window. 
 

 Fix all objects: 
This button fixates all objects in the Preview window. This means that if you change 
position of one or many objects and click this button all objects will assume current 
positions when you later reset the Preview window. 
 

 Fix selected object: 
This button fixates the selected object in the Preview window. This means that if you 
change position of one selected object and click this button the object will assume 
current position when you later reset the Preview window. 
 

 Preview Run/Stop:  
Press this button when you want to start the preview session. Press again when you 
want to stop the session. 
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3.3.6 The Actions window 

 

With Cult3D Designer, you get some pre-made 
actions. With these you can control your scene and 
object to your desire. You connect an action to an 
event, and then connect the selected data (i.e. object, 
sound, etc.) to the action you want the data to 
perform. 
 

Figure 19: The Actions window 
 
 
3.3.7 The object Properties window  
Object properties stores data used by your presentation. Each object in the scene has a 
set of properties associated with it. 
 

 
Figure 20: The object properties window 
 
By opening the Object Properties window and selecting an object, you can view the 
list of properties currently bound to the object. The window shows three columns, 
one each for name, initial value, and data type. 
 
Every ordinary object comes with a set of seven initial properties. There are seven 
system properties; Name, Translation, Rotation, Transform, ISBN, EAN, and 
Greenwich price. They cannot be removed from the object.  
 
Camera objects have only four system properties: Name, Translation, Rotation, and 
Transform. 
     
In addition to the provided system properties, you can add user properties. Press the 
Add property  button in the Object Properties window to open the Add property 
dialog. Each added user property must be given a unique name. 
 
TIP. The name must be 7 bit ASCII and must not contain the following special 
characters: period (.), minus (-), plus (+), asterisk (*), left and right parenthesis (()), 
colon (:), and slash (/), since these characters will confuse the expression parser. 
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 By selecting a property and pressing the Ps button you can access an individual 
component of another property (Ps for sub-property). For example, if you want to 
access the y component of the object's Rotation property, you select Rotation and 
press Done. This shows the Add Property dialog so you can give the new sub-
property a name and a type (in this case, let's choose the name “rotation Y” and the 
type Float or Integer).  
 
When you click the Add button, a second dialog shows and let you specify what 
component of Rotation you want to attach “rotation Y” to. Click “Y axis” component 
and press Done. You will now be able to directly manipulate the y component of the 
Rotation property through the name “Rotation Y”. It will never be possible to delete 
system properties. 
 
3.3.8 The events  window 

Here are all events in the scene displayed, for another view of your created scene 
criteria. This lets you manipulate existing events to change their types for instance. 
This is much quicker than deleting the old event, creating a new one to take its place 
and finally to reconnect all the connections. 
 
If you for instance want to change an event type you can easily do it here, instead of 
removing the old event with all it's connections and then creating a the new one and 
connecting the old and new one together. You do this by selecting the desired event 
in the event window and clicking the edit button. Here you can change the event type 
and also see the parameters the event. 
 

 
Figure 21: The Event window 
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3.4 Exercises 

 
Read 

Here you will explore the Cult3D Designer by doing. It is important to 
go through the Exercises for each file  in chronological order since they 
are constructed to lead up to a presentable result step by step. 

 
 
3.4.1 World start and Arcball 
 

 
Read 

Here you will make an object rotate round its own pivot point. You 
will use the World start event, the Arcball action and the 
Centerpoint scene to achieve this.  
 
When using the Arcball action the object will be given special 
features like rotate, zoom and translation (movement).  
 
You will work with the designer file Drawer.c3d. 

 
 

 
 
This is a descriptio n of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 
 

World Start  

You will find this Event on the left side of the 
Event map window. 
 
This Event is triggered when the scene loads. 

    
 Actions: 

 
 

  
 

Arcball 

You will find this Action under the category 
Object motion in the Actions window. This 
Action lets the user manipulate the object 
directly.  
 
A Left mouse click rotates the object. 
A Right mouse click zooms the object. 
Right and Left mouse click moves the object.  
 
Rotation is relative to the object's pivot point.  
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Exercise  

Open drawer.c3d and make the drawer object rotate around is own 
pivot point. 
 
1. Click the Start button. 

2. Select Program and Cult3D Designer to start the program. 

3. Select Load Cult3D Designer file in the File menu 

4. Select drawer.c3d and click the Open button. 

5. Drag a World start  object to the Event map window. 

6. Activate the Scene graph window. 

7. Select Centerpoint under Root node . 

8. Drag and drop the Centerpoint to the Event map window. 

9. Select Object motion in the Actions window. 

10. Drag a Arcball action to the World start (event_1) and 

release the mouse button when you see a black square. 

11. Drag the Centerpoint icon to the Arcball icon. 

12. Save the project file as drawer arcball.c3p. 

 
 
 

 

When you are finished you will be able to see black lines that 
connects the icons to each other. If you select World start 
(Event_1) you’ll see that the line will turn yellow. This is to 
indicate an action. 
 
To try out all events and actions you made you can go to the 
preview window and press the Play button. 
 

 
Finish 

 
Hold down the left mouse button to rotate  
 

 
 

Hold down the right mouse button to zoom. 

 
 

Hold down the left and right mouse button to move the 
object. 
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3.4.2 Event and Translation 
 

 
Read 

Here you will make the drawer move. You will use the Left mouse 
click event, the Translation action and the Front left box scene to 
achieve this .  
 
If you want an object to move from one point to another you will 
need an event that determines what will activate the sequence, an 
action that determines HOW it will move and an object that 
indicates WHAT is going to be moved. 
 
You will continue to work with the designer file Drawer.c3d and 
the project file drawer arcball.c3p. 

 
 

 

This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event map window. 
 
This Event is triggered when you click the left 
mouse button. 
 
Normally, Windows users have a two-button 
mouse (left and right) while Macintosh users use 
a one-button mouse (left). Macintosh users can 
use the control key to simulate the right mouse 
button. 

    
 Actions: 

 
 

  
 

Translation 

You will find this Action under the category 
Object motion in the Actions window. 
 
Moves the selected object to a new position.  

  
 

Deactivate 
event 

You will find this Action under the category 
Object motion in the Actions window. 
 
It deactivates an event that allows you to disable 
connected events. 
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Exercise 

Continue to work with the designer file Drawer.c3d and the project 
file drawer arcball.c3p. In this Exercise you will make the drawer 
move. 
 
1. Drag a Left mouse click object to the Event map window. 

2. Activate the Scene graph window. 

3. Select Front left box. 

4. Drag the Front left box to the Event map window. 

5. Drag and drop the Front left box onto the Left mouse click 

(now Event_2). 

6. Select Object motion in the Actions window. 

7. Drag a Translation action to the Left mouse click 

(Event_2). 

8. Drag the Front left box icon to the Translation icon. 

9. Double click the Translation. The translation action 

details window will appear (With the sliders you move to a 

new position. You can also write the actual X Y Z values 

directly for the new position). 

10. Write the value 20 in the Y-axis field and press Close . 

11. Try out the movement in the Preview window by pressing 

the Play button. 

If you move the pointer over the front left box you will notice that 
the pointer turns into a hand. This is to mark that the Front left 
box has animation. 
 
Left click on the front left box and it will open. If you click on it 
again the box will move 20 steps further. This will happen every 
time you click on the box. 
 
You will now need the Deactivate event to deactivate the Event_2 
after the animation has been executed. 
 
12. Select the Actions window.  

13. Select the category Event. Drag and drop Deactivate event 
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onto Event_2. 

14. Click the right mouse button on the deactivate event action 

and select Parameters. 

15. Select Event_2 on the left side and click the Add button and 

then OK. 

16. Try out the movement in the Preview window by pressing 

the Play button. 

17. Save the project file as translation.c3p 
 
 
 

 

 
Finish 

As you may notice the animation will be executed just once. If you 
go back to the Event map window and select Event_2 you will see 
that the black line will turn green. This is to indicate a selected 
event. 

 
Figure 22: Event and translation 
 
To try out all events and actions you made you can go to the 
preview window and press the Play button. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

The Event Map window 
should look like this 
when you are finished. 
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3.4.3 An event activating an other event 
 

 
Read 

In this exercise  you will c reate the opposite movement (translation) 
to the last exercise. This event will be activated after the event in 
the previous exercise has been completed. 
 
This should happen: 1. The drawer opens. 
  2. Close the drawer is activated. 
  3. The drawer closes. 
  4. Open the drawer is activated. 
 
When you have two events attached to the same object and one 
event creates a movement of 20 and the other event creates a 
movement of –20 the result will be 0. The object will not move. It 
is important to isolate the events and then to connect them to each 
other. 
 
You will continue to work with the designer file Drawer.c3d and 
the project file translation.c3p. 

 
 

 

This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event map window. 
 
This Event is triggered when you click the left 
mouse button. 

    
 Actions: 

 
 

  
 

Translation 

You will find this Action under the category 
Object motion in the Actions window. 
 
Moves the selected object to a new position.  

  
 

Activate 
Event 

 

Events can be either active or inactive. An 
inactive event cannot be triggered until it has 
been activated by an “Activate event” action. 

  
 

Deactivate 
event 

You will find this Action under the category 
Object motion in the Actions window. It 
deactivates an event that allows you to disable 
connected events. 
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Exercise 

Continue to work with drawer.c3d. In this Exercise you will make 
the drawer close after it has been opened in the last exercise . 
 

1. Drag and drop a Left mouse click to the Event map 

window. 

2. Drag Front left box to Event_3. 

3. Drag a TranslationXYZ to Event_3. 

4. Drag the Front left box to TranslationXYZ. 

5. Double click on the TranslationXYZ icon. 

6. Write the value –20 for the y -axis. This is the opposite value 

for the y-axis for the translation connected to Event_2. 

 

Now you have to make sure that Event_3 is deactivated. 

Event_3 has to be activated by Event_2 in order to execute 

properly. If not, both events will neutralise each other and 

nothing will happen. 

 

7. Click the right mouse button on Event_3. 

8. Deselect Initial Activation. Event_3 will be grey. The only 

way to trigger Event_3 is that another event activates it.  

9. Drag an Activate event action to Event_2. 

10. Click the right mouse button on the Activate event icon. 

11. Select Parameters . 

12. Select Event_3. You do this since Event_2 will activate 

Event_3. 

 

If you try the object in the preview window you can open and 

close the drawer. If you click a third time on the drawer it 

will move 20 steps inwards. To correct this you will need to 

make sure that Event_3 only triggers once. 
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13. Drag a Deactivate event action to Event_3. 

14. Click the right mouse button on the Deactivate event icon. 

15. Select Parameters . 

16. Select Event_3. 

17. Drag an Activate event action to Event_3. 

18. Click the right mouse button on the Activate event icon. 

19. Select Parameters . 

20. Select Event_2. 

21. Save the project file as Event activation.c3p. 

 
 
 

 

 
Finish 

Now you should be able to open and close the drawer many times 
in a row without any strange effects. The Event map window 
should like the picture below when you are finished. 
 
 

 
Figure 23: An event activating an other event 
 
To try out all events and actions you made you can go to the 
preview window and press the Play button. 
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3.4.4 Rotation 
 

 
Read 

This section deals with the problem to make a part of an object 
rotate  from its local centre. You will use the Left mouse click 
event, the Rotation action and the Right door scene to achieve this. 
 
You will continue to work with the designer file Drawer.c3d and 
the project file Event activation.c3p. 

 
 

 
 
This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event map window. 
 
This Event is triggered when you click the left 
mouse button. 

    
 Actions: 

 
 

  
 

Rotation 

You will find this action under the category 
Action/Object in the Actions window. 
 
Rotates the selected object. 

 
 
 
 

 
Exercise 

In this exercise you will make a part of an object rotate from its 
local centre. You will work with the designer file Drawer.c3d and 
the project file Event activation.c3p. 
 
1. Drag and drop a Left mouse click to the Event map window. 

2. Drag a Right door object from the category Centerpoint in the 

Scene graph window to the Left mouse click event (Event_4). 

3. Drag and drop a RotationXYZ action from the category 

actions/object motion to the Event_4 . 

4. Drag the Right door object to the RotationXYZ action. 

5. Double click the RotationXYZ action in the Event map 
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window. 

6. Set the value for the Z-axis to 90. 

7. Click OK.  

 

When you set the value in either translation or rotation you’ll be 

able to see the action in real-time in the preview window. 

Sometimes it can be difficult to know which axis to select. 

In the preview window you’ll find this button . 

If you click on it you will be able to see three lines in three different 

colours: red, green and blue, RGB. It’s equivalent to X Y Z. 

R=X, G=Y, B=Z 
 
8. Drag the action Deactivate event from the category 

actions/event to the Event_4 in the Event map window. 

9. Drag Event_4 back to the Deactivate event. 

10. Save the project file as rotation.c3p. 
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Finish 

When you are finished the Event map window should look like 
this: 
 

 
Figure 24: Rotation 
 
To try out all events and actions you made you select the Preview 
window and press the Play button. Click the right door in the 
drawer. The right door should open.  
 
When you click the right door again it should close. 
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3.4.5 Animation Play 
 

 
Read 

With the function Animation Play you can control the 
movements of an object that is pre-animated in 3D Studio Max. 
 

 
 

 

This is a description of the Events and Actions that you will use 
in the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event Map window. 
 
 
This Event is triggered when you click the left 
mouse button. 

    
 Actions: 

 
 

  
 

Deactivate 
event. 

 
 

 
Vertex 

Animation 
play 

You will find this Action under the category 
Event in the Actions window. 
It deactivates an event and allows you to disable 
connected events. 
 
 
You will find this Action under the category 
Object motions in the Actions window. 
Control the movements of an object that is vertex 
animated in 3D Studio Max. 
 

  

 
Exercise  

Start Cult3D Designer and select LOAD Cult3D Designer file in 
the File menu.  
 
1. Select animation play.c3d  and click the Open button. 

 
2. Drag a Left mouse click object to the Event map window. 

(It will be named Event_1). 
 

3. Select Deactivate event (under Event in the Actions 
window). 
 

4. Drag and drop a Deactivate event onto Event_1. 
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5. Drag the Event_1 back to the Deactivate event. 
 

6. Activate the Scene graph window. 
 

7. Select the Taper (under Objects). 
 

8. Drag the Taper to the Event map window and drop it onto 
Event_1. 
 

9. Activate the Actions window and select Vertex-level 
animation. You can now see the action Vertex Animation 
play. 
 

10. Drag Vertex animation play the Event map window and 
drop it onto Event_1. 
 

11. Drag the Taper onto Vertex animation play. 
 

12. Double-click the Vertex animation play in the Event map 
window. The Transform controller action details window 
will now show. 
 

13. Set Starting key frame to 0 and Ending key frame to 14. 
 

14. Select Stretch duration and set the value to 2000 ms. 
 

When you change the value of the key frame you’ll see the 
changes in the preview window. You can also select and change 
the time duration on the animation. You can either prolong or 
shorten the duration of the animation. 
 
Transition time defines how long the transition should take 
between the current object animation position to the next start. 
 
With the loop option checked the animation will play over and 
over again. 
 

 
15.  Click the Close  button. 

 
16. Save the project file as animation play.c3p  
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Now you see a black line that connects the icons to each other. If 
you select Left mouse click (Event_1) you will see that the lines 
turn yellow. This is to indicate an action. 
 
 
When you are finished the Event map window should look like 
this. 
 

 
Figure 25: Vertex animation play 

 
Try the Animation play by pressing play in the preview window. 

 
Finish 

 
Point at the Taper icon and click the left mouse button. 
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3.4.6 Vertex animation jump to  
 

 
Read 

The Animation jump to  function makes an object jump to a 
desired position.  It will morph from the current position to the 
new position. 
 

 
 

 

This is a description of the Events and Actions that you will use 
in the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event Map window. 
 
 
This Event is triggered when you click the left 
mouse button. 

    
 Actions: 

 
 

  
 

Deactivate 
event. 

 

 
Vertex 

Animation 
jump to 

You will find this Action under the category 
Event in the Actions window. 
It deactivates an event and allows you to disable 
connected events. 
 
 
This Action you will find under the category 
Vertex level animation in the Actions window. 
Function; jumps directly to a desired position in 
the animation. Setting the Transition Time to be 
greater than 0 makes the object morphing 
between the current position and the new 
position during the specified time. 
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Exercise  

Start Cult3D Designer and select LOAD Cult3D Designer file in 
the File menu.  
 
1. Select animation jump to.c3d and click the Open button. 

 
2. Drag a Left mouse click object to the Event map window. 

(It will be named Event_1). 
3. Select Deactivate event (under Event in the Actions 

window). 
 

4. Drag and drop a Deactivate event onto Event_1. 
 

5. Drag the Event_1 back to the Deactivate event. 
 

6. Activate the Scene graph window. 
 

7. Select the Taper (under Objects). 
 

8. Drag the Taper to the Event map window and drop it onto 
Event_1. 
 

9. Activate the Actions window and select Vertex level 
animation. 
You can now see the action Vertex Animation jump to . 
 

10. Drag Vertex animation jump to the Event map window 
and drop it onto Event_1. 
 

11.  Drag the Taper onto Vertex animation jump to. 
 

12.  Double-click the Vertex animation jump to in the Event 
map window.  The Vertex animation jump to details 
window will now show. 
 

13.  Give both Transition time and Key frame the value 2.  
 

14.  Click the Close button. 
 

15. Save the project file as animation jump to.c3p 
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Now you see a black line that connects the icons to each other. If 
you select Left mouse click (Event_1) you will see that the lines 
turn yellow. This is to indicate an action. 
 
 
When you are finished the Event map window should look like 
this. 
 

 
Figure 26: Vertex animation jump to  
 
Try out the Vertex animation jump to  by pressing play in the 
preview window. 
 

 
Finish 

 
Point at the Taper icon and click the left mouse button. 
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3.4.7 Edit with time line 
 

 
Read 

This practise will show how to make sequences start in the order 
we want them too. You will see that the time lineview is necessary 
to make actions start, one after the other.  

 
 

 

This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event Map window. 
 
 
This Event is triggered when you click the left 
mouse button. 

    
 Actions: 

 
 

  
 

Deactivate 
event 

 
 

 
Rotation 

XYZ 

 

You will find this Action under the category 
Event in the Actions window. 
It deactivates an event, which allows you to 
disable connected events. 
 
 
Rotates the selected object. You can select 
different values for X, Y and Z rotation. 
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Exercise 

Start Cult3D Designer and select LOAD Cult3D Designer file in 
the File menu.  
 
1. Select minidisc.c3d and click the Open button. 

 
2. Drag a Left mouse click object to the Event map window 

( It will be named Event_1). 
 

3. Select Deactivate event (under Event in the Actions 
window). 
 

4. Drag and drop a Deactivate event onto Event_1. 
 

5. Drag the Event_1 back to the Deactivate event. 
 

6. Activate the Scene graph window. 
 

7. Under Objects you will find Minidisc.  
 

8. Open the Minidsic structure by clicking the + sign. Now you 
can see the object Level-eject. 
 

9. Select the Level-eject and drag in onto Event_1 the Event 
map window.  
 

10. Select Rotation XYZ (under Object motion in the Actions 
window) and drag it onto the Event_1. 
 

11. Drag the Level-eject to Rotation. 
 

12. Now you will have to repeat the steps 11 and 12 to give the 
Level-eject two rotations. 

 
Below you will learn how to make the Level-eject rotate. 
 
13. Double click the Rotation XYZ action to show the R otation 

action details window. 
 

14. Set the value for the x-axis to 54 and press Close. 
 

15. Double click the second Rotation. 
 

16. Set the value for the x-axis to -54 and Set Performance 
duration to 500, it will make the Level-eject move up faste r. 
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17. press Close. 

 
Press Play in the preview window. So far it does not work 
properly because we have not checked the blocking option. 
The first action needs to be finished before the next one 
starts. 
 

18. Click the right mouse button on Event_1. Select Edit with 
time line. 
 

19. Drag the second rotation starting point to the point where the 
first rotation ends. 
 

20. Save the project file as Minidisk time line.c3p. 
  

 
Now try out the animation by pressing Play in the Preview 
window. 
 
When you are finished the Event map window should look like 
this. 
 

 
 
Figure 27: Time line view 
 

 
Finish 

 
Point at the Eject-level and click the left mouse button. 
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3.4.8 Play sound. 
 

 
Read 

Here you will make the Minidisk play music when its Play 
button is pressed. 

 
 

 

This is a description of the Events and Actions that you will use 
in the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event Map window. 
 
 
This Event is triggered when you click the left 
mouse button. 

    
 Actions: 

 
 

  
 

Deactivate 
event 

 
 

 
Play Sound 

 
 

 

You will find this Action under the category 
Event in the Actions window. 
It deactivates an event, which allows you to 
disable connected events. 
 
 
 
This Action is located under the category Sound 
in the Actions window. 
Plays a sound as defined by a sound resource 
(sample, MIDI, wav.)  
 

  
 

 
Exercise  

Start Cult3D Designer and select LOAD project in the File 
menu. This exercise should be made after exercise 3.4.7. 
 
1. Select the file Minidisk time line.c3p and click the Open 

button. 
 

2. Drag a Left mouse click object to the Event map window 
(It will be named Event_2). 
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3. Select the Left mouse click (Event_2) and click the right 
mouse button. In the menu that will show, select Change 
name. 
 

4. Change the name Event_2 to Sound on and press OK.  
 

5. Activate the Scene graph window. 
 

6. Under Objects you will find Minidisc.  
 

7. Open the Minidsic structure by clicking the + sign. Now 
you can see the object Button-PlayPause . 
 

8. Select the Button-PlayPause and drag in onto  the Sound 
on event in the Event map window. 
 

9. Select Play Sound (under Sound  in the Actions window) 
and drag it onto the Sound on event in the Event map 
window. 
 

10. To select sound, go to the Window menu and select Sound. 
 

11. Press the Add button and you will go directly to the to the 
sound catalogue for Cult3D Designer. 
 

12. Select the sound file guitardelay01.wav and press the Open 
button. 
 

13. Grab the file guitardelay01.wav from the sound-window 
and drop it in the Event map window. 
 

14. Close the Sound window. 
 

15. Drag the file guitardelay01.wav on to the Play sound 
action. 
 

16. Save the project file as minidiscsound.c3p . 
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Now try the Sound by pressing Play in the preview window. 
If you want to change the starting- or ending position of the song, 
double-click the Play sound icon and make your selections. 
 
When you are finished the Event map window should look like 
this. 
 

  
Figure 28: Play sound 
 

 
Finish 

 
Click the left mouse button to start the music. 
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3.4.9 Stop sound. 
 

 
Read 

Here you will make it possible to stop the music from 
playing. 

 
 

 

This is a description of the Events and Actions that you will 
use in the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of 
the Event Map window. 
 
This Event is triggered when you click the 
left mouse button. 

    
 Actions: 

 
 

  
 

Stop Sound 

This Action is located under the category 
Sound in the Actions window. 
Stops playing selected sound. 

  
 

 
Exercise 

This exercise should be made after exercise 3.4.8 . 
 
Start Cult3D Designer and select LOAD Project in the File 
menu.  
 
1. Select the file minidiscsound.c3p and click the Open 

button. 
 

2. Drag a Left mouse click object to the Event map 
window (It will be named Event_3). 
 

3. Select the Left mouse click (Event_3) and click the right 
mouse button. In the menu that will show, select Change 
name. 
 

4. Change the name Event_3 to Sound off and press OK. 
 

5. Activate the Scene graph window. 
 

6. Select the Button stop and drag in onto the Sound off  
event in the Event map window. 
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7. Select Stop Sound (under Sound in the Actions 

window) and drag it onto the Sound off event in the 
Event map window. 
 

8. Drag the file guitardelay01.wav on to the Stop sound 
action. 
 

9. Save the project file as minidiscstop sound.c3p. 
 
 
 

 

Now you can both play the music and turn it off. 
 
When you are finished the Event map window should look 
like this. 
 

  
Figure 29: Stop sound 
 

 
Finish 

 
Click the left mouse button to start the music and 
click it again to stop. 
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3.4.10 The Timer 

 

 
Read 

The timer event starts after defin able duration of time. By double 
clicking on the timer icon you can enter a time value. The time 
value may vary depending on your computer capacity. 
 
We will use a timer from an event. Therefore we will continue to 
work with the minidiscstopsound.c3p file 
You can also do this exercise by using the edit time line view.  

 
 

 
 
This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Timer 

This event is triggered after an author definable 
duration. By double-clicking the timer icon you 
can change the delay. The delay time is 
dependent on the speed of the processor. 

    
 Actions: 

 
 

  
 

Activate 
Event 

Events can be either active or inactive. An 
inactive event cannot be triggered until it has 
been activated by an “Activate event” action. 

   

 
Deactivate 

Event 

 
This action deactivates an event, which allows 
you to disable other events. 

   

 
Translation 

 
Moves the selected object to a new position. 
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Exercise 

Continue to work with minidiscstopsound.c3d. In this Exercise you 
will create and set a timer for an event. 
 
1. Drag an Activate event action from actions/event and drop in 

on the Event_1 event. 

2. Drag a Timer event and drop it in the Event map window. 

3. Drag the Timer event to the Activate event action. 

4. Click the right mouse button on the Timer event and deselect 

the option Initial activation (it will be activated by Event_1). 

5. Drag a Deactivate event action to the Timer event 

6. Drag the Timer event to the Deactivate event action and drop 

it when you see a black square. 

7. Drag a Translation action from the action category 

actions/object motion to the Timer (Event_4) 

8. Drag the minidisc-media scene from the Scene graph window 

to the Translation action 

9. Double click on the Translation action. 

10. Set the value for the y -axis to –20. 

11. Double click on the Timer to make the parameter input 

window pop up. 

12. Set the value to 800. 

13. Save the project file as minidisctimer.c3p. 
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Finish 

After 800ms after triggered “Event_1” the minidisk-media will 
move. 
 
The Event map window should like this when you are finished. 
 
 
 
 

 
 
Figure 30: The Timer 

 
To try out all events and actions you made you can select the 
Preview window and press the Play button. 
 
You may also use the feature Edit with time line to do this 
exercise. 
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3.4.11 Event activating an other event 
 

 
Read 

In this exercise you will learn how to make an event activate 
another event. This function makes it possible to activate a chain of 
events by starting one event. 

 
 

 

This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 

 
Look 

 

 
 

 
 

 
Left mouse 

click 
 
 
 

 
Timer 

You will find Events on the left side of the Event 
Map window. 
 
This Event is triggered when you click the left 
mouse button. 
 
 
 
 
 
 
This event is triggered by the duration that you 
define. By double-clicking the timer icon you 
can change the delay. The delay time is 
dependent on the speed of the processor. 

    
 Actions: 

 
 

   

 
Activate 

event 
 
 

 
Deactivate 

event 
 

 
Translation 

 

This Action is placed in the category Event in 
the Actions window. 
Events can be either active or inactive. An 
inactive event cannot be triggered until it has 
been activated by an “Activate event” action.  
 
This Action is placed in the category Event in 
the Actions window. 
It deactivates an event and allows you to disable 
connected events. 
 
This action is found in the category Object 
motion in the Actions window. 
A selected object is moved to a new desired 
position.  
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Exercise 

This exercise should be made after exercise 3.4.9 . 
You must open two files, one Cult3D Designer file and one Cult3D 
Project file, to do this exercise. 
 
1. Start Cult3D Designer and select Load Project file in the 

File menu.   
 
2. Select minidisc timer.c3p and click the Open button. 

 
3. Drag a Left mouse click object to the Event map window 

(It will be named Event_4). 
 

4. Select Deactivate event (under Event in the Actions 
window). 
 

5. Drag and drop a Deactivate event onto Event_4. 
 

6. Drag the Event_4 back to the Deactivate event action. 
 

7. Activate the Scene graph window. 
 

8. Select the Minidisc-Media  and drag it onto Event_4 in the 
Event map window. This makes it possible to click the 
Minidisc-Media . 
 

9. Select Translation XYZ (under Object motion in the 
Actions window). 
 

10. Drag and drop Translation XYZ to the Event_4. 
 

Now the Minidisc-Media must be linked to the Translation XYZ. 
 
18. Drop the Minidisc-Media to the Translation XYZ action in 

the Event map window. 
 

19. Double-click the action Translation XYZ that is linked to e 
Event_4 in the Event Map window. 
 

20. Set the value for the y-axis to 20. 
 

Now you can test the function ”Event activating an other event” by 
pressing Play in the Preview window and clicking the 
Level_Eject. 
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The Minidisc will move 20 steps on the y -axis. If you click the 
Minidisc-Media the Minidisc will move back to the starting 
position. So far we have not made it possible to start any action 
when clicking the Lever-eject again in the preview window. 
 
Below you will learn how to activate the Level-eject again. 
 
21. Click with the right mouse button on Event_4 in the Event 

Map window and deselect Initial activation. 
 

22. Select Activate event (under Event in the Actions window). 
 

23. Drag and drop the Activate event to the Event_1 in the 
Event Map window. 
 

24. Drag Event_4 to the Activate event action in the Event map 
window (to activate Event_4 after Event_1 is triggered). 
 

25. Select  a new Activate  event (under Event in the Actions 
window). 
 

26. Drag and drop the Activate event to the Event_4 in the 
Event Map window. 
 

27. Drag Event_1 to the Activate event action in the Event map 
window.  

 
28. Save the project file as minidiscactivate.c3p. 
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Finish 

Try out the function ”Event activating an other event” by pressing 
Play in the Preview window and clicking the Level_Eject. 
 
The Minidisc will move 20 steps on the y-axis. If you click the 
Minidisc-Media the Minidisc will move back to the starting 
position. 
 
When you are finished the Event map window should look like 
this. 
 

  
Figure 31: Event activating an other event 
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3.4.12 Event deactivating an other e vent 
 

 
Read 

In this exercise you will learn how to make an event deactivate 
another event. In the exercise 3.4.10 we still have the problem to 
prevent the music from playing when the Minidisc media is out. 

 
 

 

This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 
 

 
 

 
Left mouse 

click 
 
 
 

 
Timer 

You will find Events on the left side of the Event 
Map window. 
 
This Event is triggered when you click the left 
mouse button. 
 
 
 
 
 
 
This event is triggered by the duration that you 
define. By double-clicking the timer icon you 
can change the delay. The delay time is 
dependent on the speed of the processor. 

    
   

 
Exercise 

This exercise should be made after exercise 3.4.10. 
You must open two files, one Cult3D Designer file and one  
Cult3D Project file to do this exercise . 
 
1. Select LOAD Cult3D Project file in the File menu.  
 
2. Select minidiscactivate.c3p and click the Open button. 

 
To prevent the music to play when the Level-Eject is 
triggered follow the instructions in step 5 and 6. 
 

3. Select Deactivate event (under Event in the Actions 
window). 
 

4. Drag and drop a Deactivate event action to Event_1. 
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5. Drag and drop the action Sound on to the new Deactivate 
event. 
 
Now we have to make it possible to play the music when the 
Minidisc-Media is in. See step 6 – 8 below. 
 

6. Select Activate event (under Event in the Actions window). 
 

7. Drag and drop the action Activate event to Event_4 in the 
Event map window. 
 

8. Drag the event Sound on to the Activate event in the Event 
map window. 
 
The next step is to prevent the Minidisc-Media from being 
triggered when the music is playing. See step 9-11 below. 
 

9. Select Deactivate event (under Event in the Actions 
window). 
 

10. Drag and drop a Deactivate event to the event Sound on in 
the Event map window.  
 

11. Drag the Event_1 to the new Deactivate event in the Event 
map window. 
 
The Level_eject must be activated when the music is turned 
off. See step 12-18 below. 
 

12. Select Deactivate event (under Event in the Actions 
window). 
 

13. Drag and drop a Deactivate event to the event Sound off  in 
the Event map window.  
 

14. Drag the event Sound off to the new Deactivate event in the 
Event map window. 
 

15. Select Activate event (under Event in the Actions window). 
 

16. Drag and drop an Activate event to the event Sound off  in 
the Event map window.  
 

17. Drag the event Event_1 to the new Activate event in the 
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Event map window. 
 

18. Select Activate event (under Event in the Actions window). 
 

19. Drag and drop an Activate event to the event Sound on in 
the Event map window.  
 

20. Drag the event Sound off to the new Activate event in the 
Event map window. 
 

21. Select Activate event (under Event in the Actions window). 
 

22. Drag and drop an Activate event to the event Sound off  in 
the Event map window.  
 

23. Drag the event Sound on to the new Activate event in the 
Event map window. 
 

24. Select Deactivate event (under Event in the Actions 
window). 
 

25. Drag and drop a Deactivate event to the event Sound on in 
the Event map window.  
 

26. Drag the event Sound on back to the new Deactivate event 
in the Event map window. 
 

27. Save the p roject file as minidisc complete.c3p. 
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Try the functions for the Minidisc by pressing Play in the Preview 
window. 
 
The Minidisc will move on the y-axis. If you click the Minidisc-
Media the Minidisc will move back to the starting position. 
Music will play/stop playing when you click the play button. 
 
When you are finished the Event map window should look like 
this. 
 

 
Figure 32: Event deactivating an other event 
 

 
Finish 

 
Point at the Eject-level in the preview window and click 
the left mouse button. 
 

 



  Chapter 3: Working with the Cult3D Designer 
 

 Page 71 

3.4.13 Keyboard key press 
 

 
Read 

In this exercise  you will learn how use a keyboard key to control an 
action. We will make a fish move when we press a key. 
 

 
 

 

This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 
 

 
 

 
World start 

 

 
Keyboards 
key press 

 

 
Timer 

You will find Events on the left side of the Event 
Map window. 
 
This event is triggered when the scene loads. 
 
 
 
 
This event occurs when the end-user presses the 
specified key on the object associated with the 
event.  
 
 
 
 
This event is triggered after an author definable 
duration. By double-clicking the timer icon you 
can change the delay. The delay time is 
dependent on the speed of the processor. 

    
    
 Actions: 

 
 

   

 
Arcball 

 
 

 
 Activate 

event 
 
 

“Left mouse click” rotates the object 
Right mouse click zooms in the object 
Right and “Left mouse click” allows you to 
move the object  
Rotation is relative to the object's pivot point.  
 
Events can be either active or inactive. An 
inactive event cannot be triggered until it has 
been activated by an “Activate event” action. If 
“Initial activation” is checked, then the event is 
active. If it is not checked, then you need to 
activate the event before it can be triggered. 
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Translation 

XYZ 
 

 
Vertex 

animation 
jump to 

activate the event before it can be triggered. 
Moves the selected object to a new position.  
 
 
 
 
 
 
This action is only used when you have changed 
one or several vertexes in 3D Studio Max. It 
creates a morph from the starting point to the 
stop point in a vertex. 
 

  
 

 
Exercise 

You have to open the Cult3D Designer file fish.c3d to do th is 
exercise. 
 
1. Start Cult3D Designer and select LOAD Cult3D Designer 

file in the File menu.  
 
2. Select the file fish.c3d and click the Open  button. 

 
3. Drag the World start event (from the left side of the Event 

map window) to the Event map window. World start will 
be named Event_1. 
 

4. Select Arcball (under Object motion in the Actions 
window). 
 

5. Drag and drop the Arcball action to the World start event 
(Event_1) in the Event map window. 
 

6. Select box02 in the Scene graph-window. 
 

7. Drag and drop box02 to the Arcball action in the Event map 
window. 
 

8. Drag the Keyboards key press event (from the left side of 
the Event map window) to the Event map window. 
Keyboards key press will be named Event_2. 

 
9. Double click on the keyboards key press and select key nr 1 

on your keyboard then press add 
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10. Select Activate event (under Event in the Actions window). 

 
11. Drag and drop a Activate event on the Keyboards key press 

event (Event_2) in the Event map window.  
 

12. Drag a Timer event to the Event map window. 
 

13. Click the right mouse button on the Timer (Event_3) and 
deselect Initial activation. 
 

14. Select TranslationXYZ (under Object motion in the 
Actions window). 
 

15. Drag and drop the TranslationXYZ on Timer (Event_3) in 
the Event map window.  
 

16. Drag box02 in the Event map window to the 
TranslationXYZ action. 
 

17. Double click the TranslationXYZ action so the Action 
details window will show.  
 

18. Set the x-axis value to –50.  
 

19. Drag and drop a Vertex animation jump to action to 
Event_3. 
 

20. Drag box02 to the Vertex animation jump to. 
 

21. Double click the Vertex animation jump to action. 
 

22. Type 500 in the Transition type field and drag Ending 
keyframe to 3. Click the close button. 
 

23. Drag a new Vertex animation jump to  action to Event_3. 
 

24. Drag box02 to the Vertex animation jump to. 
 
25. Double click the second Vertex animation jump to  action. 

 
26. Type 500 in the Transition type field and drag Ending 

keyframe to 2. Click the close button. 
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27. Click the right mouse button on the Event_3 and select Edit 
time line view. 
 

28. Drag the starting point of the second Vertex animation 
jump to action to the point where the first Vertex animation 
jump to  action ends. 
 

29. Save this project-file as fish keypress.c3p. 
 

  
 
 

 
Finish 

Try the functions for the Fish by pressing Play in the Preview 
window. Hold keyboard key 1 down to start the motion and steer 
the fish with the pointer. Don’t be alarmed when the fish won’t 
stop, we will correct that in exercise 3.4.14. 
 
When you are finished the Event map window should look like 
this. 
 

 
Figure 33: Keyboard key press 
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3.4.14 Keyboard key release and stop translation 
 

 
Read 

In the exercise  3.4.13 we made it possible to start the movement of 
a fish and steer it with the mouse pointer. Now we will add 
functions that will stop the movement when we release a keyboard 
key. We will also learn how to control movements in the vertex-
structure. 
 

 
 

 

This is a description of the Events and Actions that you will use in 
the Exercise below. 
Events: 
 

 
Look 

 

 

 
Keyboards 
key press 

 

This event occurs when the end-user presses the 
specified key on the object associated with the 
event. By double clicking the “Keyboard Button 
Pressed” event you can define which keys or 
sequences of keys that should trigger the event. 
 

 Actions: 
 

 
  

 
Deactivate 

event 
 
 
 
 
 

Stop  
 
 

  
Vertex 

Animation 
jump to 

This action deactivates an event, which allows 
you to disable other events. (See the example 
under “Activate event” for a discussion of how to 
use the activation state of an event.) 
 
 
 
Stops object motion actions 
 
 
 
 
This action is only used when you have changed 
one or several vertexes in 3D Studio  Max. It 
creates a morph from the starting point to the 
stop point in a vertex. 
 

  
 
 

You will find Events on the left side of the Event Map 
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Exercise 

This exercise should be made after exercise 3.4.13. 
You must open two files, one Cult3D Designer file and one Cult3D 
Project file, to do this exercise. 
 
1. Select LOAD Cult3D Project file in the File menu.  

 
2. Select fish keypress.c3p and click the Open button. 
 
3. Drag the event Keyboards key release (from the left side of the 

Event map window) to the Event map window. Keyboards 
key release will be named Event_4. 

 
4. Double click on the keyboards key press and select key nr 1 on 

your keyboard then press add 
 

5. Drag and drop a Deactivate event action to the event 
Keyboards key release (Event_4) in the Event map window. 
 

6. Drag Event_3 (the timer) to the Deactivate event action. 
 

7. Drag a Stop action from the Object motion category to 
Event_4. 
 

8. Drag box02 to the Stop icon. 
 

9. Double click the Stop action and select all actions except 
Arcball. Click the arrow that points to the right. 
 

10. Drag and drop a Vertex animation jump to onto Event_4. 
 

11. Drag box02 to the Vertex animation jump to action. 
 

12. Double click the Vertex animation jump to and type 500 in 
the Transition time field. Let Ending keyframe remain on 0. 
 

13. Save the project file as fish keyrelease.c3p . 
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Finish 

Try the functions for the Fish by pressing Play in the Preview 
window. Hold keyboard key 1 down to start the motion and steer 
the fish with the pointer. Notice the smooth movement of the fish. 
 
When you are finished the Event map window should look like 
this. 
 

 
Figure 34: Keyboard key release and stop 
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3.4.15 Reset 
 

 
Read 

Reset stops any animation in progress and resets the object to its 
original translation, rotation and zoom values.  
 
An event must be reset to be able to be triggered a second time. 
Normally you use automate reset that you will find when you right 
click on an event. If this option is not selected then you must use a 
reset event. 
 
You will continue to work with the fish.c3d and the fish 
keyrelease.c3p. 
 

 
 

 
 
 
 
This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Keyboards 
key press  

This event occurs when the end-user presses the 
specified key on the object associated with the 
event. By double clicking the “Keyboard Button 
Pressed” event you can define which keys or 
sequences of keys that should trigger the event. 

    
 Actions: 

 
 

   
 
 

Reset 

Reset is different from Reset event. An object or 
an action doesn’t need to be reset unless you 
want everything go back to its original position. 
 
 

 
 
 
 
 
 
 
 
 
 

R 
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Exercise 

Continue to work with the fish.c3d and the fish keyrelease.c3p. In 
this exercise you will reset the objects when a key is pressed. 
 
1. Drag and drop a Keyboard’s key press event to the Event 

map window. 

2. Drag a Reset action from the actions/object motion action 

category and drop it on the Event_5 event. 

3. Drag box02  to the Reset action. 

4. Double click on the Event_5 event. 

5. Select 2 and press Add. 

6. press OK. 

7. Drag and drop a Deactivate event action to Event_5. 

8. Drag and drop Event_3 (the timer) onto the Deactivate event 

9. Save the project file as Fish reset.c3p. 
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Finish 

The Event map window should like this when you are finished. 
 

 
Figure 35: Reset 
 
Run the animation in the Preview window. When holding down 
keyboard key 2 the animation will go back to its original position. 
 

 
 
3.4.16 Hide and unhide  

 

 
Read 

You will use this action if you have an object that you don’t want 
to be shown from the beginning of the animation and show it later. 
 
You will work with the designer file tv.c3d. 

 
 

 
 
This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
World start 

This event is triggered when the scene loads. 
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Left mouse 

click 
 

The end-user presses the left mouse button on the 
object associated with this event. 

 Actions: 
 

 
  

 
Activate 

Event 

Events can be either active or inactive. An 
inactive event cannot be triggered until it has 
been activated by an “Activate event” action. 

   

 
Deactivate 

Event 

 
This action deactivates an event, which allows 
you to disable other events. 

   

 
Hide object 

 
Hides the connected object from the viewer. 

   

 
Unhide 
object 

 
 

 
If the object is hidden this action makes it 
visible. 

 
Exercise 

In this exercise you will work with the designer file tv.c3d. In this 
designer file there are two screen objects. One shows a black TV-
screen and the other shows a picture. When we start the animation 
the black TV-screen will be visible. Later on the TV-screen will be 
shown and the black TV-screen will be hidden. 
 
1. Open the tv.c3d file in the Cult3D Designer 

2. Drag a World start event to the Event map window. 

3. Drag screen02 under circle01 in the Scene graph window to 

the Event map window. 

4. Drag the action Hide object from the category render in the 

Actions window and drop it on the Event_1 event in the 

Event map window. 

5. Drag screen02 to the Hide object action. 
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6. Drag a Left mouse click event to the Event map window. 

7. Drag cylinder01 from the Scene graph window to the 

Event_2 event. 

8. Drag the action Unhide object from the action category 

render to the Event_2 event. 

9. Drag screen02 to the action Unhide object. 

10. Drag a Deactivate  event action to Event_2 event. 

11. Drag Event_2 to the Deactivate event. 

12. Drag screen01 from the Scene graph window to the Event 

map window. 

13. Drag the action Hide object from action category Render to 

the Event_2 event. 

14. Drag screen01 to the Hide object action. 

15. Click the Play button in the Preview window. 

 
If you click the red button the TV-screen with a picture will appear. 
 
16. Drag a Left mouse  click event to the Event map window. 

17. Drag cylinder01 to the Event_3 event. 

18. Drag the action Unhide object from the action category 

Render to the Event_3 event. 

19. Drag screen01 to the Unhide object action. 

20. Drag the action Hide object from the action category Render 

to the Event_3 event. 

21. Drag screen02 to the Hide object action. 

 
Step 15-21 makes it possible to show screen01 and hide screen02 
invisible. 
 
22. Click the right mouse button on the Event_3 event and 

deselect Initial activation. 

23. Drag a Deactivate  event action from actions/event to the 
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Event_3 event. 

24. Drag the Event_3 to the Deactivate event action. 

25. Drag an Activate event action from the Event category in 

the Actions window to the Event_2 event. 

26. Drag the Event_3 event to the Activate event action. 

27. Drag an Activate event action from the Event category in 

the Actions window to the Event_3 event. 

28. Drag Event_2 to the new Activate  event action. 

29. Save the project file as TV hide unhide.c3p. 

 
Now you can turn it of and on again. 

 
 
 

 

 
Finish 

Now you can “turn on” and “turn off” the television. 
 
The Event map window should like this when you are finished. 
 

 
Figure 36: Hide and unhide 
 

To try out all events and actions you made you can select the 
Preview window and press the Play button. 
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3.4.17 Set the background colour 

 

 
Read 

In this exercise you will change the background colour for the 
preview window. 
 
You will continue to work with the designer file tv.c3d and the 
project file TV hide unhide.c3p. 

 
 

 
 

 
Look 

This is a description of the Events and Actions that you will use in 
the Exercise below. 

 Actions: 
 

 
  

 
Set 

background 
colour 

Sets the background to a new definable colour. 

   
 

 

 

 
Exercise 

Change the background colour. 
 
Continue to work with the designer file tv.c3d and the project file 
TV hide unhide.c3p. 
 
 
1. Drag a Set background colour action from the actions 

category Render to the Event_1 (“World start”) event. 

2. Double click on the Set background colour action. 

3. Select a colour. 

4. Click the OK button. 

5. Click the Play button in the Preview window. 

 
You can also link it to another type of event. 
 
6. Drag the Set background colour action from actions/render 

to the Event_2 event. 
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7. Double click the Set background colour action. 

8. Select a colour. 

9. Click the OK button. 

10. Click the Play button in the Preview window. 

 
 
 
 

 

 
Finish 

When you click the left mouse button in the Preview window the 
background should change to your selected colour. 
 
The Event map window should like this when you are finished. 
 

 
Figure 37: Set the background colour 
 
To try out all events and actions you made you can select the 
Preview window and press the Play button. 
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3.4.18 Links in the Scene graph. 
 

 
Read 

When you create a link from one object to a second object and the 
second object has a movement or an animation attached to it the 
first object will automatically be affected by the movement 
/animation. 
 
You will continue to work with the designer file Link.c3d and the 
project file Link.c3p . 

 
 

 
 
 
This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Keyboard 
key press 

This event occurs when the end-user presses the 
specified key on the object associated with the 
event. By double clicking the “Keyboard Button 
Pressed” event you can define which keys or 
sequences of keys that should trigger the event. 
 
 

 Actions: 
 

 
  

 
Rotation xyz 

You will find this Action under the category 
Object motion in the Actions window. 
 
Rotates the selected object.   
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Exercise 

In this exercise you will give three objects (the sun, the earth and 
the moon) different rotation. They will all rotate around their own 
pivot point. You will later change the links and observe how the 
objects affect each other. 
 
The earth and the sun have their pivot point in the centre. The 
moon has its pivot point in the centre of the earth. You can control 
this by selecting the object you want to examine in the Scene 
graph window. 
 

1. Open the file link.c3d. 

2. Drag and drop a Keyboard key press to the Event map 

window. 

3. Double click the Keyboard key press event and give it 

keyboard key nr 1. 

4. Drag Earth from the Scene graph window to the Event map 

window. 

5. Drag a Rotation xyz  action to Event_1. 

6. Drag the Earth  to the Rotation xyz action. 

7. Double click the Rotation xyz action. 

8. Select Show axis in the Preview window. Now you can see 

the pivot point of the object. 

9. Write 360 in the z-axis. 

10. Click loop and close . 

11. Drag and drop a new Keyboard key press to the Event map 

window. 

12. Double click the Keyboard key press event (Event_2)  and 

give it keyboard key nr 2. 

13. Drag a Rotation xyz  action to Event_2. 

14. Drag the Sun to the Rotation xyz icon. 

15. Select Camera02 in the Scene graph window. You can now 

see the Sun in the Preview window. 
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16. Double click the Rotation xyz. 

17. Give the z -axis the value 360. 

18. To make the sun rotate  slowly you write the value 5000 in the 

time field next to Z. 

19. Click loop and then close. 

20. Test the rotation in the Preview window. 

21. Click nr1 and the Earth will rotate around its own axis. 

22. Click nr2 and the Sun will rotate around its own axis. 

23. Stop the preview. 

24. Drag a Keyboard key press event to the Event map 

window. 

25. Drag a Rotation xyz  action to the Event_3. 

26. Drag the moon to the Rotation xyz action. 

27. Double click on Event_3 and give it the value nr3. 

28. Double click the Rotation xyz and give the z -axis the value   

-360. 

29. Write 2000 in the Time field for the z-axis. 

30. Select loop. 

31. Select the Scene graph window. 

32. Drag Earth to the Sun. This will link the earth to the sun, 

which means that sun will not be affected by the rotation of 

the earth, but the earth will be affected by the rotation of the 

sun. 

33. Test in the Preview window. 

34. Click nr1 and the earth will start rotating round its own axis. 

35. Click nr2 and the sun will start rotating round its own axis. 

The earth will now follow the rotation of the sun. 

36. Return to the Scene graph window. 

37. Drag the moon to the sun. The moon will now be linked to 

the sun. 
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the sun. 

38. Test in the Preview window. 

39. Click nr3 and the moon will start rotating round the earth. 

40. Click nr1 and the earth will start rotating round its own axis 

41. Click nr2 and the sun will start rotating round its own axis. 

The earth will follow the rotation of the sun and the moon 

will follow the rotation of the sun and at the same time keep 

its own rotation round the earth. 
 

 
Finish 

 
When pressing the key nr1, 2 and 3 more then once the objects will 
start to rotate faster, this because the rotation will accumulate. To 
prevent this you just deactivate the events with a deactivate event. 
(see exerciser3.4.2 nr12) 
 
You should see the picture below in the Event map window. 
 
 

 
Figure 38: Links in the Scene graph 
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3.4.19 Change the pointer icon 

 
Read 

It is possible to select or create your own pointer icon in Cult3D. In 
order to create your own pointer icons you need a program, like 
Microangelo or similar. 
 

  
 

 
Look 

 
Figure 39: The icon program Microangelo  
 
 

 Actions: 
 

 
   

 
Set mouse 

pointer 

 Sets the mouse pointer icon. 
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Exercise 

In this exercise you will "load" the pointer icon of your choice. 

You will later on change the pointer icon.  

 

1. Select Cursor in the Window menu. 

2. Click the Add button. A dialog box will appear. 

3. Click the Add button in the new dialog box. 

4. Find and select the cursor icon of your choice and click the 

add button. You can select more than one if you want to. 

5. When you are finished click the Close button. 

6. Select the cursor of your selection. 

7. Press the Hot Spot button. 

8. Mark on a cell to define the new Hot Spot position. 

9. Press close. 

 
Now you will try the new pointer icon. 

 
6. Select Cursor in the Window menu. 

7. Click the Edit button. 

8. Click the Test drive button. 

9. Click the Try it button to see what it looks like. 

10. Click the Close button when you are finished. 

 

You will now change the pointer icon within the Cult3D object. 

 
11. Drag and drop a Set mouse pointer action from the action 

category Cursors/Sprites to the desired event in the Event 

map window. 

12. Click the right mouse button on the Set mouse pointer action 

in the Event map window and select Parameters . 

13. Click on the desired pointer icon and then click OK. 
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14. Test the icon in the Preview window by using the event it is 

connected to. 

 
 
 

 

 
Finish 

You should see a picture that looks something like the one below 
in the Event map window. 
 

 
Figure 40:The Set mouse pointer action with an attached cursor. 
 
You can try the new cursor in the preview window by pressing the 
Play button. 
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3.4.20 The particle system part 1: Periodic waveform 
 

 
Read 

The particle system can be used to obtain flare and rain effects. As 
always it is your own imagination that sets the limits for what you 
can achieve. However, it is perhaps advisable to get acquainted 
with this particular feature of the program before you let your 
creativity flow freely.   

 
 

 
 
 
 
This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 
Left mouse 

click 

You will find this Event on the left side of the 
Event map window. 
 
This Event is triggered when you click the left 
mouse button. 
 
 

    
 Actions: 

 
 

  
 

Translation 
XYZ 

You will find this Action under the category 
Object motion in the Actions window. 
 
Moves the selected object to a new position.  

  
 

Rotation xyz 

You will find this Action under the category 
Object motion in the Actions window. 
 
Rotates the selected object.   

  
 

Periodic 
waveform 

 

You’ll find this under translation and rotation 
under the category Object motion in the Actions 
window. The Periodic waveform controller 
generates different mathematically periodic 
waveform, sine for an example. Choose the 
periodic waveform in the menu, click on the Set 
button and the waveform generator window is 
shown. 
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Exercise 

The purpose of this exercise is to explore the particle system. You 

will also use actions Translation and Rotation that you already are 

familiar with. Before you start please open the file Match.c3d.  

 

1. Drag and drop a Left mouse click to the Event map 

window. 

2. Drag Match from the Scene graph window to Event_1. 

3. Drag a Translation action to Event_1. 

4. Drag Match to the Translation action. 

5. Double click the Translation icon. 

6. Set the value for X to 126. 

7. Select Repeat count, write 1 and then close. 

8. Drag a Rotation xyz  action to Event_1. 

9. Drag Match to Rotation xyz . 

10. Double click the Rotation icon. 

11. Set the value for Z to –18. 

12. Drag a new Translation action to Event_1. 

13. Drag Match to the Translation action. 

14. Double click the Translation icon. 

15. Hold down the left mouse button on the V in the y-axis. 

16. Select the periodic waveform. 

17. Click on the Set button on the y-axis. 

18. Write 500 in the Time field in the Sustain  square. 

19. Write –750 in the Amplitude field. 

20. Unlock the period and the final period. 

21. Write 500 in the Period field. 

22. Write 10000 in the Final period field. 

23. Select the Absolute checkbox. 

24. Close the windows.  
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All actions will happen at the same time. You have to change this 

in order to accomplish a proper movement. 

 

25. Click with the right mouse button on Event_1. 

26. Select Edit with time line view. 

27. Drag the third Translation to the point on the time line 

where the Rotation ends. You do this by dragging the white 

square at zero to the right. 

28. Save as Match.c3p 

 
 
 

 

 
Finish 

You should see the picture below in the Event map window. 
 
 

 
Figure 41: The particle system part I 
 
To try out all events and actions you made you can go to the 
preview window and press the Play button. 
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3.4.21 The particle system part 2: A flame  
 

 
Read 

Here you will continue to explore the particle system. You will 
place particles on the Chamfer box and explore how they appear in 
the preview window. You should be able to see a flame. 
 
Continue to work with the file Match.c3p. 
 

 Actions: 
 

 
   

 
Start 

Particle 

 Starts the particle action 

  
 

 
Exercise 

In this exercise you will write the settings to accomplish a flame. 

You will also select  

 

10. Click the right mouse button on the ChamferBox02 under 

match in the Scene graph window. 

11. Select New and Particle system. 

12. Right click on the Particle and select Details. You will now 

write colour values to create a flame. 

13. Select the first arrow to the left in the colour setting. 

14. Write 0 on Red Green and Blue. 

15. Select the second arrow to the left. 

16. Write 255 on Red Green and Blue. 

17. Select the third arrow to the left. 

18. Write 255 on Red and Green. Write 0 for Blue. 

19. Select the fourth arrow to the left. 

20. Write 255 on Red. 

21. Write 0 on Green and blue. 

22. Select the last arrow to the left. 

23. Write 0 on Red Green and Blue. 
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24. Press the start test button. 

25. Write the value 10 in the Particle size square. 

26. Write the value 80 in the Emit speed square. 

27. Go to the Action window 

28. Drag a Start Particle emission action from the category 

particle system to the Event_1. 

29. Drag Particle from the Scene graph window to the Start 

particle icon. 

 

All actions will happen at the same time. You have to change 

this in order to accomplish a proper flame. 

 

30. Click with the right mouse button on Event_1. 

31. Drag the Particle systems so it starts a little after the 

Translation starts. 
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Finish 

You should see the picture below in the Event map window. 
 
 

 
Figure 42: The particle system part II 
 
To try out all events and actions you made you can go to the 
preview window and press the Play button. 
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3.4.22 Rotation look at 
 

 
Read 

The purpose of this exercise is to make an objects movement 
depend of the movement of another object. 

 
 

 
 
 
 
This is a description of the Events and Actions that you will use in 
the Exercise below. 
 
Events: 
 

 
Look 

 

 

 

World Start: 
This event is triggered when the scene loads. 
 
 

    
 Actions: 

 
 

   

 
Arcball 

 

You will find this Action under the category 
Object motion in the Actions window. 
Lets the end-user manipulate the object directly. 
Left mouse click rotates the object 
Right mouse click zooms in on the object 
Right and Left mouse click moves the object.  
Rotation is relative to the object's pivot point.  
 
 

    
    

  
 

 
Exercise 

Start Cult3D Designer and select LOAD Cult3D Designer file in 
the File menu.  
 
1. Select the file lookat.c3d  and click the Open button 

 
We will start making it possible rotating the head. 
 

2. Drag a World start object to the Event map window. 
(It will be named Event_1). 
 

3. Select Arcball (under Object mo tion in the Actions 
window). 
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4. Drag and drop an Arcball onto Event_1 (World start). 
 

5. Activate the Scene graph window. 
 

6. Select Quad Patch ( under Objects ). 
 

7. Drag the Quad Patch to the Event map window and drop it 
onto the action Arcball. 
 

8. Double click the action Arcball in the Event map window. 
The window Transform controller action details will show. 
Select the value Camera Frame in the filed named Frame. 
 

9. Click Close. 
 
Below we will make the eyes fixate on a given spot. 
  

10. Select Rotation look at (under Object motion in the Actions 
window). 
 

11. Drag and drop a Rotation look at onto Event_1 (World 
start). 
 

12. Click the right mouse button on Rotation look at in the 
Event map window and select parameters. 
 

13. Select sphere02 in the left table, click Add and then OK. 
 
 

14. Double click Rotation look at. The window Transform 
controller action details will show.  
In the middle of the window there is a white square, which is 
used to decide the direction of the eyes (focus). 
Keep the window open and proceed with step 15-20. 
 

15. Activate the Scene graph window. 
 

16. Select camera01 (under Objects). 
 

17. Drag the target camera01 to the white square in the 
Transform controller action details window. You can 
change camera angle when you want to (select another 
camera). 
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18. Click the radio button Z (Axis to keep aligned) and Inver 

sign. 
 

19. Click the radio button Loop (to keep the motion going). 
 

20. Click Close. 
 

21. Drag and drop another Rotation look at onto Event_1 
(World start). 
 

22. Click the right mouse button on the new Rotation look at in 
the Event map window and select parameters. 
 

23. Select sphere01 in the left table, click Add and then OK. 
 
 

24. Double click the new Rotation look at. The window 
Transform controller action details will show. Keep the 
window open and proceed with step 25-30. 
 

25. Activate the Scene graph window. 
 

26. Select camera01 (under Objects). 
 

27. Drag the target camera01 to the white square in the 
Transform controller action details window. 
 

28. Click the radio button Z (Axis to keep aligned). 
 

29. Click the radio button Loop. 
 

30. Click Close. 
 

31. Save the project file as look at.c3p.  
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Finish 

We have now made it possible to move the head while the eyes are 
focused on a fixed point.  
If the head is further away from the target the eyes will look more 
real. 
The Event map window should like the picture below when you 
are finished. 
 

 
Figure 43: Rotation look at 
 
Try out the Rotation look at by pressing play in the preview 

window. 

 
 

Point at the Head, hold down the left mouse button and 
move the mouse. The eyes will look in the same direction 
regardless of the position of the head. 
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4 Presenting the final result 
Now you have reached the stage when you are ready to present the result of your 
work. 

4.1 Compression Settings in the Save Object Dialog 
You have to consider compression in order to make your presentation file execute 
properly. Down below you can read about the compression possibilities when you 
save your work 
 
4.1.1 The Object motion tab 
Object level animation controls the compression levels for the animation matrices. 
"Object level" means that the animation in question is the matrix channel.  
 
The matrix channel provides uniform rigid translations and orientations for each 
object in the scene. 
 
Therefore, the first slider controls the compression level for the translation channel, 
while the second slider controls the compression level for the orientation channel. 
 

 
Figure 44: The object motion tab 
 
4.1.2 The Vertex motion tab 
Vertex level animation is a secondary animation channel. It controls the motions for 
each vertex in each object. At this level, each vertex is associated with its own motion 
path. Therefore, objects containing vertex level animations are usually much larger 
than those containing only plain object level animations. 
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This tab contains a check box called Optimise . If the optimise option is set, the 
Designer will try to export the minimum vertex level animation information required 
to run the current presentation. The Optimise optio n is particularly effective when the 
animations in the presentation are controlled by Animation "jump to" actions. 
 
This option should not be selected when the Vertex Compression slider (just below 
the Optimise checkbox) is set to a value lower than 100%. 
 

 
Figure 45: The vertex motion tab 
 
4.1.3 The Audio tab 

The slider controls the compression for the digital sound (WAVE files). MIDI files 
are not affected by this setting. The compression setting will not change the sample 
frequency or stereo/mono setting. So if the sample is a 44.1KHz stereo sample, then it 
will still be a 44.1KHz stereo sample after the compression. The samples will only 
get more and more distorted the higher the compression level, while the size of the 
sample will decrease. 
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Figure 46: The audio tab 
 
 

Types of Compression 
 Loss-less: Lossy: 
Sound 
 

 
The data is stored as is. 
Sounds from *.wav 
files are compressed 
roughly 50%. MIDI 
data is not compressed 
 

 
The sound data is compressed using 
for instance a wavelet algorithm. 
The object creator can set the 
fidelity of the compression. 

 
4.1.4 The Mesh tab 

The mesh compression tab contains a set of combo boxes. These are used to set the 
compression level for the meshes contained in  the presentation. Since it is a 
geometric compression, it does not reduce the number of polygons in the mesh, only 
the geometric precision of the objects.  
 
The mesh compression algorithm is not lossy in any other respect than that it can lose 
precision of the objects' geometry data. 
 
Losing precision of the geometry can generate small visual artefacts on some objects 
when high compression is used. If that should occur, try using a lower compression 
for the mesh. However, the High setting works for the majority of objects. 
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Figure 47: The mesh tab 

 

4.2 The Internet 
This will help you to get Cult3D objects placed on your site. There are some things 
you need to do in order to make Cult3D run smoothly on your website. 
 
Add a new mime-type on your web server. 
Adding the mime-type is necessary for any plug-in or file format that isn’t standard 
or default for the server. It helps the server to execute the embedded cult3d section 
better. The mime-type for Cult3D is: 
 

application/x-cult3d-object  
and the default suffix is .co 

 
Add some special Cult3D HTML code. The Cult3D HTML code needs some special 
attributes. A correct code should look like this: 
 

<object classid="clsid:31B7EB4E-8B4B-11D1-A789-00A0CC6651A8" 
width="400" height="300" 
codebase="http://www.cult3d.com/download/ 
cult.cab"> 
<param name="SRC" value="file.co">  
<embed pluginspage="http://www.cult3d.com/newuser/index.html"  
src="file.co" width="400" height="300" color="000000" 
type="application/x-cult3d-object" 
bgcolor="000000"></embed></object> 
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Code explanation: 
The <object> code is read by Internet explorer, and the <embed> code by Netscape. 
That is why you need to write things like the filename at two places. 
 
 
4.2.1 General notes about Java in Cult3D 

Every project that uses Java must have one (and only one) start up class. The start-up 
class must implement Cult3DScript and the method "public void Cult3dDestroy()".  
 
 The Cult3dDestroy() Java method is automatically called upon when the 
Cult3D object is exited as when closing the application that started the Cult3D object 
(Web browser, Acrobat, activeX enabled programs etc). 
 
 For the Java method to show up in the designer the Java method must be declared as 
 public and return void and have a String as its only parameter, for example public 
void methodName(String s). The Java Startup class must contain a public constructor 
with no parameter. 
 
 To add Java to the Designer choose window->Java Action, click Add and choose the 
Java classes you will use in the project. In the "startup class" text field enter the Java 
startup class file, which implements Cult3DScript (Ex. ChangeTexture.class). 
NOTE: the .class must also be entered. 
 
 If you create a project with more than one Java class, it should prove wiser to let the 
startup class have instances of the subclasses and call the subclasses methods. 
 
 Example: 
 
 import com.cult3d.*; 
 
 public class StartupClass implements Cult3DScript 
 { 
        private SubClass subclass = new SubClass(); 
 
        public StartupClass() 
        { 
        } 
 
        public void cultMethod(String s) 
        { 
                subclass.doThing(); 
        } 
 
        public void cult3dDestroy() 



Chapter 4: Presenting the final result 
 

 Page 108  

        { 
        } 
 } 
 
 
Change Texture  
This example class shows how to change textures on Cult3D objects. To begin with 
you have to know the name of the texture you want to change. You can see the 
texture name when exporting models in 3D Studio Max. You must also load the 
images you want to change to as resources. 
 
Choose Window->Resources in Cult3D Designer. 
 
EXAMPLE CODE 
import com.cult3d.*; 
import com.cult3d.world.*; 
 
import java.awt.*; 
import java.util.*; 
 
public class ChangeTexture implements Cult3DScript 
{ 
        private static final int MAX_DISPLAYS = 10; 
 
        // Name of texture from 3D Studio Max 
        private String texName = "texture_name"; 
 
        private Hashtable          hash = new Hashtable(); 
        private Texture         tex; 
 
    private int counter = 0; 
 
        public ChangeTexture() 
        { 
        } 
 
        // the method which will be called from Cult3D Designer 
        public void change(String s) 
        { 
                if (counter == 0) 
                { 
                        setTexture("texture1.jpg"); 
                        counter++; 
                } 
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                else if (counter == 1) 
                { 
                        setTexture("texture2.jpg"); 
                        counter++; 
                } 
                else if (counter == 2) 
                { 
                        setTexture("texture3.gif"); 
                        counter=0; 
                } 
        } 
 
        private void setTexture(String imgName) 
        { 
                TexureImage img = (TextureImage)hash.get(imgName); 
 
                if (img == null) 
                { 
                        // warning: can lock the cultobject until loaded. 
                        // Experienced Java programmer can use a  thread to load 
                        // the texture. 
                        img = (TextureImage)Cult.getImage(imgName); 
                        hash.put(imgName, img); 
                } 
 
// Warning: can lock the cult object until loaded. 
                // Experienced Java programmer can use a thread to load 
                //the texture. 
                if (tex == null) 
                { 
                        tex = new Texture(texName); 
                } 
 
                tex.setTexture(img); 
        } 
 
        public void cult3dDestroy() 
        { 
        } 
} 
 
Change Colour 
 
Changing the colour of a Cult3D object. 
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The Java method setDiffuseColor() takes an RGB value as its parameters. The RGB 
values are between 0..1 
 
If you want colour black use (1, 1, 1) and so on. 
 
To convert from colour range 0..255 to 0..1 divide the 255 with your desired 255-
value. 
 
Example: To get the colour grey which is 127,127,127 converted to 0..1 range divide 
255 with 127 for all three parameters. 
 
 
EXAMPLE CODE 
 
import com.cult3d.*; 
import com.cult3d.world.*; 
 
public class ChangeColor implements Cult3DScript 
{ 
    private CultObject pen         = new CultObject("Cylinder02"); 
        private Material   penMaterial = new Material(true); 
 
        public ChangeColor() 
        { 
        } 
 
        public void changeToYellow(String s) 
        { 
        penMaterial.setDiffuseColor(1, 1, 0); 
        pen.setMaterialAt(0, penMaterial, false, false); 
        } 
 
        public void cult3Destroy() 
        { 
        } 
} 
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5 Practice your skills  
 
Practice 1: Steer an object 
 
Use the designer file shark.c3d 
 
In this practice you will use the object Line01 and the proper events and actions to 
steer the shark at the same time as it swims forward. The Shark object is pre-
animated in 3D Studio Max in order to make a realistic fin movement. 
 
The final result should look something like shark.co 
 
 
Practice 2: Make a camera lens retract 
 
Use the designer file crowncamera.c3d  
 
You will make the lens go in to the camera. After that the hatch should close. Some 
parts are pre -animated between 0 and 30 in order to make the “accordion” retract. 
 
 
Following parts are pre-animated: 
 
Accordion 
Big Metal Square 
Front lentil 
Lens 
Back lentil 
Trigger  
 
 
Practice 3: Fly an airplane 
 
Use the designer file Sopwith3.c3d 
 
You will make the propeller spin. The plane should be able to fly and be controlled 
by the user. You will also add sound to the airplane. The sound should vary 
depending on if the plane is stationed on the ground or is flying in the air. Use 
particles to create smoke when the plane is flying.  
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Appendix 1: Events and Actions 
 

Events: 

 

World Start: 
This event is triggered when the scene loads. 
 
 

 

World Stop:  
Occurs when you quit the scene, i.e., load another scene. 
 

 

World Step:  
Gets triggered every time that the scene gets rendered, which 
normally happens about 15 or 30 times per second. All this 
depends on the user computer and the scene and object 
running. If for instance the object is small and uses very few 
polygons, then this event can get triggered up to 200 times 
per second. This event is useful to call Java actions, which 
have real time constraints or things that should continuously 
happen. 
 

 

Timer:  
This event is triggered after an author definable duration. By 
double-clicking the timer icon you can change the delay. The 
delay time is dependent on the speed of the processor. 
 

 
 

 
 

 
 

(Left, Middle, Right) Mouse click on object: 
The end-user presses the specified mouse button on the 
object associated with this event. By selecting the left, 
middle or right event type you can choose to trigger on the 
left, middle or right mouse button.  
 
Normally, Windows users have a two-button mouse (left and 
right), while Macintosh users use a one-button mouse (left). 
Macintosh users can use the control key to simulate the right 
mouse button. 

 
 
 

Keyboard’s key press: 
This event occurs when the end-user presses the specified 
key on the object associated with the event. By double 
clicking the “Keyboard  Button Pressed” event you can 
define which keys or sequences of keys that should trigger 
the event. 
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Keyboard’s key release:  
Works like the “Keyboard’s key press” event, but activates 
only when the end-user has released the key specified. By 
double clicking the “Keyboard’s key Release” event you can 
define which keys or sequences of keys that should trigger 
the event. 
 

 

Object Motion Completion: 
An object motion action has been completed. 
 
 

 

Sound Completion:  
A sound action has been completed. 
 

 

Manual: 
The only time this event is triggered is when another event 
triggers it. 
 

 

Actions: 
 

The Object motions category  
 

 Reset:  
Resets translation and rotation values of the object to initial values. Very useful if you 
have been fiddling with the object for a while and want to get back to initial 
conditions. 
 
 

Rotation LookAt: 
This action enables a node to “look at” another node. Which means that the object or 
camera is always aimed at the target object, no matter where the target object is. 
Choose X, Y, or Z -axis to “look” with. 
 

 Rotation XYZ: 
Rotates the selected object. 
 

 Translation XYZ:   
Moves the selected object to a new position. With the sliders, you select a new 
position for the object, or you can type the new x, y, and z values directly into the 
provided fields. The Performance duration field lets you set the duration of the 
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translation in milliseconds (ms). (For example, to make a move take 5 seconds, set 
the Performance duration to 5000.) If Loop is checked, then the translation is 
repeated. 
 

 Animation play: 
Plays the Matrix animation (rotation and translation) that you have created in 3D 
Studio MAX. 
 

 Animation jump to:  
Plays the Matrix animation (rotation and translation). Jumps to a desired position in 
the animation. When setting the Transition Time to be greater than 0, the object will 
morph between the current position and the new position during the specified time. 
 
 

 stop: 
Stops the playing and movements of the selected object. 
 
 

 Arcball: 
Lets the end-user manipulate the object directly.  
“Left mouse click” rotates the object 
Right mouse click zooms in on the object 
Right and “Left mouse click” you can move the object  
Rotation is relative to the object's pivot point.  
 
Vertex-level animation 
 

 Vertex animation play 
Plays the Vertex animation (individual vertex translations and morph) that you have 
created in 3D Studio MAX. 
 

 Vertex animation “jump to” 
Plays the Vertex animation (individual vertex translations and morph) that you have 
created in 3D Studio MAX. When setting the Transition Time to be greater than 0, 
the object will morph between the current position and the new position during the 
specified time. 
 
 
The Camera category 

 Select Camera: 
Selects a camera for the scene. 
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 Stereoscopic features:  

Selects a camera for the scene but with the option to add stereoscopic rendering from 
the selected camera 
 
The Sound category  

 System Beep: 
Plays a system beep.  
 

 Play Sound: 
Plays a sound as defined by a sound resource (sample, MIDI, wav.) To select a sound 
resource, use the menu window and then Sounds.  
 
Tip: Under Windows, it is currently only possible to play one sound and one MIDI 
song at the same time. (Unless you have more than one sound board, properly 
installed and configured in an MCI compatible way. Since MIDI tracks are also 
played using MCI, they are subjected to all the above restrictions.)  
 

 Stop Sound: 
Stops the playing of the selected sound resource. 
 
The Connection category 

 Load URL: 
Double-click the load URL icon to enter destination and target. The URL specifies 
what to load and target field (optional) allows you to  specify what frame to load the 
URL into. You would enter "http://www.Cult3D.com" in the URL field and "main" 
in the target field. If you want the same effect as when activating the HTML link: <A 
TARGET="main" HREF="http://www.Cult3D.com">  
 

 Load Cult3D File: 
Double click the action icon to enter the destination where you can load an Internet 
file *.co file. 
 

 Send message to host: 
This action is used for sending a text message; for instance, the message can be seen 
using JavaScript. If you want your JavaScript programmed into an HTML page to get 
information from a Cult3D object, then this is the action to do it with. 
 
The Event category 

 Trigger Event: 
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The Trigger Event action lets you trigger any event at any time. For example, if you 
trigger a Timer Event, it is as if you suddenly forced that events clock to the ending 
value, thus causing any actions which the Timer Event is associated with to run 
immediately. Events of type Manual can only be triggered by a Trigger Event action. 
 

 Reset Event: 
Events can only be triggered when they are in the reset state. All events start out 
reset, but once triggered they must be reset before they can be triggered again. You 
can either do an explicit reset with a Reset Event action, or you can set it to 
automatically reset after it triggers by checking the Automatic Reset option in the 
event popup menu in the “Event map” (right-click the event to show it).  
  

 Activate Event: 
Events can be either active or inactive. An inactive event cannot be triggered until it 
has been activated by an “Activate event” action. If “Initial activation” is checked, 
then the event is active. If it is not checked, then you need to activate the event before 
it can be triggered. 
 
Example: Create a Timer Event with a duration of 60000ms (1 minute). To have the 
Timer Event trigger a System Beep action. Use the popup menu in the “Event map” 
to make the event inactive by default. Then bind an “Activate event” action to the left 
click of some object and have it activate the Timer Event. When the end-user left 
clicks the object, the “Activate event” will activate the Timer Event. One minute later 
the Timer Event will trigger the System Beep action and the user will hear a beep. 
 

 Deactivate event: 
This action deactivates an event, which allows you to disable other events. (See the 
example under “Activate event” for a discussion of how to use the activation state of 
an event). 
 

 Toggle Event Activation: 
Toggles the activation state of an event. If the event is already active, the Toggle 
Event Activation action deactivates it. If the event is not active, it gets activated. 
 

 Swap to event: 
Swaps between event actions. 
 
The Render category 

 Set Background Colour: 
Sets the background to a new definable colour. 
 

 Hide Object: 
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Hides the connected object from the viewer. 
 

 Unhide Object: 
If the object was hidden, the object becomes visible. 
 

 Bilinear Filter: 
Gives all textures in the scene bilinear textures filter  
 
 
The Expression category  

 Execute Expression: 
The Execute Expression action is used to execute the attached expression. Dragging 
an expression from the Expression window, to the ”Event map” accesses expressions. 
The icon represents the Execute Expression action itself. 
  

 Conditional Test: 
You connect other actions on either the True or False side of the Conditional Test 
action. You then use the Conditional Test action dialog to specify the details of the 
test. 
 

The action needs a property to test. To point the action to a property:  
1. Drag the property from the Object Property window for the object that owns the 

property to be tested and drop it on the Conditional Test icon (). 
 

2. In the dialog you can specify the exact condition to test and any comparison 
values needed.  
 

3. It is even possible to compare two different object properties. Simply drag the 
specific object property from the Object Properties window and release it in the 
Compare with “Edit Box”.  

 
Cursors/sprites 
 

  Set mouse pointer: 
Under the Window menu, you have a resource window called “Cursors”. In that 
dialogue box, you can add your own mouse pointers/cursors. You can also edit them 
to set your hotspot on them. 
 
You can also test-drive them, and see them in different resolutions and colors, to get a 
better understanding on how the custom cursor may look for the user that is viewing 
your object. 
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If you do not attach a Cursor resource to this action, Cult3D will reset the cursor to 
the default ones. 
 
Particle system 
 

 Start particle emission: 
Starts the emission of particles. 
 

 Stop particle emission: 
Stops the emission of particles. 
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